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S Corporations (1120S)

The basics of data entry for an S corporation (1120S) return are the same as for a 1040
return. Field- and screen-level help, shortcut keys, and navigation throughout data
entry all function as they do in the 1040. See the Drake Software User’s Manual: Tax
Year 2011 for the basics of using the program.

What’s New in Drake for S Corporations

Drake programs its tax software according to the latest IRS rules and regulations. The
2011 program reflects all changes to credits and deductions, including discontinua-
tions. For details on the new regulations for the 2011 tax year, see the IRS instructions
for Form 1120S.

ELEC Screen Changes

The ELEC screen has been revised for easier, more efficient selection of various elec-
tions available to corporations. For more information on choosing elections in Drake,
see “Elections” on page 34.

Ownership Changes

New in 2011, all ownership change information is entered on the OWN screen, which
is accessible from the General tab of the Data Entry Menu. For more information,
see “Ownership Changes” on page 19.

Income and Deduction Screens

The data entry screens for income and deductions have been revised for easier data
entry.

Only three screens are now required in order to calculate taxable income for a return:

¢ INC — Includes all items of income reported on Form 11208, page 1, lines 1b
through 5, that do not require a separate form schedule (Form 1125-A) or addi-
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tional information (income reported on Form 1065, Schedule K-1); also includes
the Schedule K — Most Common Items previously included on screen 3.

* DED — Includes all deduction items reported on Form 11208, page 1, lines 7
through 19, that do not require a separate schedule or form (Form 8846).

* 4 — Includes additional tax amounts, tax payments, and data entry fields for the
excess net passive income tax calculation.

Screens 3 and TAX have been eliminated from the 1120S package.

Multi-State Apportionment

Previously, in order to prepare a multi-state return in Drake—for a company doing
business in more than one state—you had to go to each individual state’s screens and
enter its sales, payroll, and property factors. Drake would then calculate the apportion-
ment factor on that state’s tax form.

With the new APPT screen, you can enter the apportionment information for all states
in one global location. The link to the APPT screen can be found on the States tab, or
you enter APPT in the selector field and press ENTER. (See “Multi-State Apportion-
ment” on page 16.)

Cost of Goods Sold (Form 1125-A)

In years past, Schedule A, Cost of Goods Sold, was located on page 2 of Form 1120S.
Beginning with tax year 2011, entries on screen A produce a separate form, Form
1125-A, Cost of Goods Sold.

8609 Screen

The 8609 screen (for Form 8609, Low-Income Housing Credit Allocation and Certifi-
cation) has been reorganized for easier data entry. Among the changes:

* Fields required for both Form 8609 and Form 8609-A are now separated on the
screen from the other information fields.

¢ Other fields for Form 8609-A are now located in the middle of the screen.
e  Other fields for Form 8609 are now located in the bottom half of the screen.

® Screen 8586 has been removed from the program. The program will generate
Form 8586, Low Income Housing Credit, depending on entries made to screens
8609, K1P, and K1F.

Schedule K Screen Changes

The screens for Schedule K, Shareholders’ Pro Rata Share Items, have been changed
for more efficient data entry. Changes include:

* Ifa form is required for a particular line, the corresponding field has been
replaced with a link to the screen for the required form. For example, an entry on
line 10, “Other Income,” might require that Form 6781, Gains and Losses From
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Before You Start

Section 1256 Contracts and Straddles, be completed. Rather than include a field
for this line on screen K, the program now provides a link to screen 6781.

*  Ownership change dates, originally located on a third K screen, can now be found
on the new OWN screen. For more information about the OWN screen, see

“Ownership Changes” on page 19.

Book Depreciation Schedules

A book depreciation schedule will now be printed when the Carry book accumu-
lated depreciation & amortization to Schedule L check box is marked on the L

screen (if a 4562 screen has also be completed).

Adjustment and Override Worksheets

The Adjustment Worksheet and Override Worksheet are updated each year to help you
understand what happens in the return when certain data is changed through the use of

adjustment or override fields (Figure 1).

Book-to-tax depreciation adjustment................ 3
OB e '
Book-to-tax amortization adjustment..................» ?

e e kg g A g

Figure 1: Adjustment (+/-) and override (=) fields

By default, fields that allow overrides are preceded by an equal sign (=) and display
red text. Data entered in these fields replaces, or overrides, program calculations.
Fields that allow adjustments are preceded by a plus/minus sign (+/-) and display blue
text. Data in these fields adjust program calculations by the amount entered. A posi-
tive number increases the calculated amount; a negative number decreases it.

The Adjustment and Override worksheets are available through the FAQ screen. To
access them, open the FAQ screen, click the Screen Help button (or press

CTRL+ALT+?) and click the links at the top of the window.

Before You Start

Actions you might need to take before starting an 11208 return in Drake include:

* Updating a prior-year return (if you prepared the tax return last year)

* Electing as an S corporation (if the corporation was not an S corporation last year)

Updating a Prior-Year Return in Drake

A prior-year return can be updated in three ways:

*  With all other returns in the program using Last Year Data > Update Clients

2010 to 2011 (rnot recommended)

* Asasingle return (updated one at a time) using Last Year Data > Update Clients

2010 to 2011 (recommended)
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*  When you open the return for the first time in the 2011 program and are prompted
to update it

When you update an 1120S return that was previously marked as “final,” the program
informs you that the return was marked final before prompting you to proceed.

Indicating an S Corporation

If the corporation is electing as an S corporation for the first time, it is necessary to
indicate this in the program.

S Corp Onscreen 1 in the General Information section, line A, enter the date of election as
Election an 'S corporation. On line E, enter the date incorporated.

Form 2553, Election by a Small Business Corporation, is required if the entity is mak-
ing the election with the return. In Drake, use screen 2553, accessible from the Other
Forms tab or by clicking the Form 2553 link on screen 1.

If attaching a signed Form 2553 to the return as a PDF, mark the

N[H'E Attaching Form 2553 as a PDF document box on screen 1. If not sent
as a PDF, the form must be mailed separately to the IRS before filing
the tax return. See Form 2553 instructions at www.irs.gov.

1120 to To change a “C” corporation to an S corporation (1120 to 1120S):
1120S
Go to Tools > File Maintenance > Change File Type.

Enter the EIN of the entity.

Click Continue.

Select the new return type (1120S).
Click Continue to save changes.
Click OK.

oakrwbd-=

Header Information

Screen 1 contains fields for the general information that is printed in the top section of
page 1 of Form 1120S.

Name and Address

Use screen 1 to complete the corporation name and address section of Form 1120S.
For state purposes only, if the corporation has an alternate address (such as a P.O.
box), you can enter that address on screen 2, in the Address Line 2 field at the bottom
of the screen. (Access screen 2 from the States tab, or enter 2 in the selector field and
press ENTER.)
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Tax Year

Fiscal and
Calendar
Years

Short-Year
Returns

The software uses the calendar year as the default period for all corporate returns; no
date entries are required on screen 1 for a December 31 tax year end.

The program adjusts calculations for depreciation and for gains and

NDTES losses on sales of assets based on the entity’s tax year.

For information on filing with a 52-53—week year, see “Electing a 52-
53-Week Year (Initial Return)” on page 37.

If the S corporation uses a fiscal year (where the year begins in the current calendar
year and ends in the next), specify the beginning and ending dates in the If not calen-
dar year section of screen 1.

An entity may have a short-year return if changing accounting periods with IRS
approval (Form 3115), or if this is its first or last year in business and the tax year is
not a full year.

To indicate a short-year return, use the fiscal year date fields on screen 1 to indicate
the beginning and ending dates for the current year. (These fields should not be used if
the entity is filing a full calendar-year return.)

If filing a short-year return (other than an initial or final return), you will need to pro-
vide an explanation. To do so, go to the ELEC screen and select an explanation from
the Other short year reason drop list. The explanation will be displayed at the top of
the first page of the tax return. If you do not select an explanation, an EF message will
be generated with the return, and the return cannot be e-filed.

For more information on short-year explanations, see IRS Pub. 4163.

NDTES The program may not correctly calculate depreciation, gains, or losses

for a short-year return. Depreciation for a short-year return can be
entered on screen 4562 and/or screens 6, 7, 8, and 9.

Boxes A through |

Enter most information for boxes A through I (top of Form 1120S) on screen 1. Note
that boxes C (“M-3 attached”) and F (“Total assets”) are completed automatically by
the program based on data entered elsewhere. Other boxes are:

* Box A — S election effective date

* Box B — Business activity code (From screen 1, choose a code from the line B
drop list, or click in the line B field and press CTRL+SHIFT+S to search for a code)

* Box D — Employer Identification Number (EIN) (program uses setup data as
default)

* Box E — Date incorporated

* Jtem G — Indicates first year as S corporation and inclusion of Form 2553 with
return

* Item H — Check boxes for final return, name change, address change, amended
return, and S election termination or revocation

Tax Year 2011
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* [tem I — Number of shareholders during the year (completed automatically based
on the number of K-1s; number can be overridden on line I of screen 1.)

NDTE Enter accounting method at the bottom of screen 1.

Income and Deductions

Income and deductions are entered primarily on the INC (Other Income) and DED
(Other Deductions) screens.

For information on the Schedule K items at the bottom of the INC
NDTE screen, see “Schedule K: Shareholders’ Pro Rata Share Items” on
page 18.

Gross Receipts

Enter gross receipts (Form 11208, line 1b) and returns and allowances (line 1d) on the
INC screen.

The program calculates gross receipts or sales after returns and allowances based on
gross receipts, sales, and any direct entry on line 1d.

The IRS does not require a detail (Ctrl+W) worksheet for gross receipts;
therefore, if you are using the trial balance import feature, do not

NDTE include a detail worksheet for this line—or for any other line that does
not require a detail worksheet. For more on the trial balance worksheet,
see “Importing Trial Balance Information” on page 42.

NEW FOF  Line la, Merchant card and third-party payments, is new for Form
1120S in 2011; however, because the IRS requires that a zero (0) be
2 [I I | entered on this line for 2011, the field for line 1a on the INC screen is
inactive (grayed-out).

Cost of Goods Sold (Form 1125-A)

For cost of goods sold (COGS), complete screen A (Form 1125-A, Cost of Goods
Sold).

On screen A, items 9a through 9f are direct-entry fields and follow the
NDTE format of IRS Form 1125-A. For more information on completing these
fields, press F1 or consult the IRS instructions.

Inventory Inventory amounts entered on lines 1 and 7 of screen A automatically flow to Sched-
ule L, line 3 (“Inventories™). Note that the Inventories fields on the L screen (Sched-
ule L - Balance Sheet - Assets) are overrides. Anything entered there overrides the
inventory data that flows from screen A.

6 Tax Year 2011



Drake Software User’s Manual Supplement Income and Deductions

Line 5, Other
Costs

Importing
Trial Balance
to Form
1125-A

Line 5 of Form 1125-A is designated for any applicable costs not entered on the previ-
ous lines. In Drake, two fields on screen A are provided for line 5: one for other costs
excluding depreciation, and one for depreciation (Figure 2).

Additional section 2634 costs
Other costs - excluding depreciation. ...

Depreciation.............

w@w—

Inwentary at end ofyear......
Figure 2: Other Costs and Depreciation

In the Depreciation ficld, enter any depreciation that relates to the cost of goods sold
(unless the amount is flowing from the 4562 Detail screen with COGS selected from
the For drop list). (Note that this field is an override field; an entry here overrides the
calculations from the 4562 screen.) Amounts entered in this field automatically adjust
the total depreciation that is carried to page 1 of Form 1120S. For Other costs -
excluding depreciation, use a CTRL+W worksheet. The depreciation amount is
included on the statement for other costs and should not be included in the Other
Costs worksheet.

NDTE Line 14b on the DED screen is for Form 4562 depreciation that is not

entered on screen A or elsewhere on the return.

If using the trial balance import feature (see “Importing Trial Balance Information” on
page 42), enter depreciation amounts directly into the appropriate fields on the trial
balance worksheet, not into the fields in data entry. When the trial balance is imported,
the COGS depreciation expense amount flows directly to the appropriate line of Form
1125-A and is calculated accordingly.

Ordinary Gains and Losses

The amount on line 4 (Net gain (loss) from Form 4797, Part 11, line 17) of Form 1120S
flows from Form 4797. Amounts can also flow from screen 4562, but only if that
screen shows assets sold and property type.

Other Income (Loss)

Enter all amounts for line 5, Other income (loss), on the INC screen. INC screen data
is displayed on attached statements in View mode.

Amounts from the following screens also flow automatically to line 5:

* 6478 (Form 6478, Alcohol and Cellulosic Biofuel Fuels Credit)
* 8864 (Form 8864, Biodiesel and Renewable Diesel Fuels Credit)

Additional fields on the INC screen include:

e Amount of credit for tax on fuels
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* Interest income on receivables
* Recoveries of bad debts

* Section 481 adjustments

e State tax refund

* Income from insurance proceeds

To enter income or loss from a partnership, estate, or trust, use the K1P or K1F
screen. (Click the screen links on the INC screen or access them from the Other
Forms tab).

To enter additional sources of income not shown, create a CTRL+W worksheet using
the Other Income (itemize) ficld on the INC screen.

Compensation and Wages

Enter shareholder compensation and employee wages on the DED screen. Drake has
two fields each for officer compensation and employee salaries/wages: one for non-
shareholders, and one for shareholders.

The Salaries and wages to non-shareholders field is an adjustment
field. An amount entered here is combined with any amount entered in
NDTES the Labor hired field on screen F.

The shareholder fields are used for calculating section 179 income limi-
tations; see the WK_S179L worksheet in View mode.

Credit A credit adjustment is made for the following forms:

Adjustments
* Form 5884, Work Opportunity Credit

* Form 8844, Empowerment Zone and Renewal Community Employment Credit
* Form 8845, Indian Employment Credit

The adjustment is indicated on Form 1120S with the ATT _SSW literal. (Figure 3).
Actual adjustments are shown on the ATT_SSW worksheet in View mode.

ty e fREF EGTE ] ToB BT tiang = Seeeen SrenBrendff] 15575 a0 6 ¥ 7% AT o6 T B i’ o L 2 -
6  Total income {loss). Addlines 3through S v « v s s s s e s s s s anann s nnunns p| 6 162
7  Compensation of offiCers « s s s s s s s s s s v s s s a s s s nnunnnnna TEE 7
8  Salaries and wages (less employment credits) « « s s s @ @ @ @ a e e e e - .. 8 (300)
9 Repairsand mainteflances « o so s s s s ¢ = = s 0 5 8 5 2 2 8 = 2 # " w2 Ew " EEE " EE 9
- --_...-p&*&ub‘“-\-& “ainanali o i g et - g PR e SR

Figure 3: ATT SSW literal on Form 1120S

Repairs and Maintenance

Enter repair and maintenance costs on the DED screen. An amount entered there is
combined with the amount, if any, entered in the Repairs and maintenance field on
screen F.

8 Tax Year 2011
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Bad Debts
Use the Bad debts field on the DED screen to enter the total debts that became worth-
less in whole or in part during the year, but only to the extent that such debts related to
a trade or business activity.
Enter deductible non-business bad debts as a short-term capital loss on
NDTES Schedule D (Form 1120S).
Cash-method corporations cannot take a bad debt as a deduction
unless the amount was previously included in income.
Rents

Use the DED screen to enter rent paid on business property used for a trade or busi-
ness activity. If the corporation rented or leased a vehicle, enter the total annual rent or
lease expense incurred in the trade or business activity of the entity, and then complete
Part V of the 4562 (screens 8 and 9).

N[H'E The Rents field is an adjustment field. An amount entered here is com-
bined with the amount, if any, entered in the Rent fields on screen F.

Taxes and Licenses

Enter tax and license amounts on the DED screen. Amounts are combined and the
sum generated on Form 11208, line 12 (“Taxes and licenses”). Note that credit from
Form 8846 (Credit for Employer Social Security and Medicare Taxes Paid on Certain
Employee Tips) should be entered on screen 8846, which is accessible via a link from
the DED screen. These amounts also appear on the “Taxes and Licenses Attachment,”
referred to on line 12 with the printed “ATT_STL” reference. (Figure 4.)

T Al e MR e T T e L e T DI T U s o T e T e g | e e e e g
10 Baddebls - -« ¢ & @ o 4 e e e e e e e e e e e e e e e e e e m e e e e m e 10

T = T 1 111

12 Tanes andliCENSES « v v v @ & o 4 o o @ @ v 4 s s m e m am s nnmmn e m . 12 6’589
13 IMEIEST o v v e e e e e e e e e e e e e e e aae e 13 555

Laa ,_Q_eggg,qanmoiAqémmmh_ejylwmﬂwh\ggwﬂ_rﬂ@fgp;umﬁ@a}:_‘ U N - W PO ] -

Figure 4: Notification on line 12 of the 1120S return that the
Taxes and Licenses Attachment has been produced with the return.

To keep the notification from appearing on line 12 of the return, go to the PRNT
screen and select Suppress printing of form and attachment references.

State tax amounts (income tax and franchise tax) entered on the ES (Estimated Taxes)
screen are carried to the tax computation (ATT TAX) worksheet. The state tax
amount carried from the ES screen may differ depending on which method of
accounting (cash or accrual) is used.
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Interest
Using the 11208 instruction guidelines, enter interest expense on the DED screen.
Note that the Interest expense field is an adjustment field. Any amount entered here
is combined with the amount, if any, entered in the Interest fields on screen F.
Depreciation

Enter depreciation on the 4562 screen. Select a form from the For drop list to associ-
ate the depreciable item with the correct form or activity. Data from the 4562 screens
is calculated and carried to Form 1120 and to the selected schedules or forms.

For more information on depreciation and the 4562 screen in Drake, see the Drake
Software User s Manual: Tax Year 2011.

Line 14, Line 14 of Form 11208 is reserved for depreciation that (1) is from Form 4562, and
Depreciation (2) is not claimed on Form 1125-A or elsewhere. While the program pulls data from
the 4562 screen for this line, it also provides field 14b on the DED screen specifically
for depreciation that is claimed elsewhere.

Both lines 14a and 14b on the DED screen are adjustment fields.

* Line 14a — See field-level help for further instructions and information on
how this field ties in to Form 4562.

* Line 14b — Drake recommends entering depreciation on the 4562 screen,
and then selecting COGS from the For drop list at the top of the screen. You
can also use screen A (rather than the DED screen) to enter depreciation
claimed on Form 1125-A. An entry on screen A adjusts any entry on line 14b
of the DED screen and is calculated into the total deductions for page 1 of the
1120S. If there is an entry on line 14b but not on screen A, only the line 14b
amount will be calculated into total deductions.

Depletion

Enter depletion amounts on the DED screen. Omit timber (use Form T, Forest Activi-
ties Schedules) and oil and gas properties. (Each shareholder should figure depletion.)

Advertising

Enter advertising expenses on the DED screen.

Pension and Profit-Sharing

Enter pension and profit-sharing expenses on the DED screen. Press F1 for informa-

tion on what expenses to enter. The software reduces the expense based on the credit

amount calculated from Form 8881, Credit for Small Employer Pension Plan Startup
Costs. Note that this is an adjustment field; the software uses any amount entered here
to adjust the amount flowing from Schedule F to the 1120S.
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Employee Benefits Program

Enter on the DED screen amounts for fringe benefits paid or incurred on behalf of
employees owning 2% or less of the corporation’s stock.

Do not deduct amounts that are an incidental part of a pension, profit-sharing, etc.,
plan included on line 17 or amounts reported elsewhere on the return.

Report amounts paid on behalf of more than 2% shareholders on line 7 or 8, which-
ever applies. A shareholder is considered to own more than 2% of the corporation’s
stock if that person owns, on any day during the tax year, more than 2% of the out-
standing stock of the corporation or stock possessing more than 2% of the combined
voting power of all stock of the corporation.

Note that this is an adjustment field. An amount entered in here adjusts the amount
flowing to Form 1120S from Schedule F, line 17.

Other Deductions

Enter all other deductions on the DED screen. Drake incorporates the total into line
19, Other deductions, on Form 11208S.

The following deductions, credits, adjustments, and exclusions also flow to line 19:

*  Amortization from Form 4562
*  Credit adjustment from Form 8820, Orphan Drug Credit
¢ Exclusion from Form 8873, Extraterritorial Income Exclusion

* Credit from Form 8941, Credit for Small Employer Health-Insurance Premiums

Tax and Payments

Screen 4 has fields for completing the “Tax and Payments” section of Form 1120S.
Note that some fields are overrides. Press F1 to view more information on a field.

Net Passive Income

Line 22a, “Excess net passive income or LIFO recapture tax,” could apply to an S cor-
poration if it was formerly a “C” corporation or if it engaged in a tax-free reorganiza-
tion with a “C” corporation.

To determine if the corporation must pay the tax, complete the worksheet fields on
screen 4. If completing the IRS worksheet, enter the worksheet results on screen 4.
Enter LIFO recapture directly on screen 4.

N[H'E To force the line 22a worksheet to be printed, select the applicable box
on screen 4.

Tax Year 2011 11
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Schedule D

Use screen D to enter data for Parts I and II of Schedule D (Form 11208S), Capital
Gains and Losses and Built-in Gains. Use the DTAX screen for Part I1I of Schedule D
(Form 1120S). For information on using the Schedule D import feature in Drake, see
“Schedule D Imports” in Chapter 5 of the Drake Sofiware User s Manual: Tax Year
2011.

2011 Estimated Tax

The 1120S does not have a federal estimated tax voucher. Estimated tax payments are
required only in certain situations. An S corporation must make electronic deposits of
employment, excise, and corporate income taxes using the Electronic Federal Tax
Payments System (EFTPS).

Use the ES screen to enter estimated tax payments made for tax year 2011 and esti-
mated amounts for tax year 2012. Future year amounts appear on the ES SUM work-
sheet generated with the return.

Payments with Extensions

To make a payment with an extension request, enter the amount being paid on the
7004 screen. If an extension was previously requested and a payment was made then,
enter the amount paid on screen 4, line 23b.

Tax Paid on Fuels

Use screen 4136 to enter information for Form 4136, Credit for Federal Tax Paid on
Fuels. Note that this screen actually consists of two screens, with lines 1 through 8f on
the first screen. Press PAGE UP or PAGE DOWN to go from screen to screen.

Estimated Taxes

Use the ES screen to enter federal and state estimated taxes paid in 2011. If the return
was updated in Drake from 2010, this information is carried over. Note that this infor-
mation will be overridden by any entry in the Current-year estimated tax payments
field on screen 4.

Estimated Payments for 2012

Use the ES screen for 2012 estimated payments. To enter the amount to be credited,
used the OP to 2012 field. Note that this information will be overridden by any entry
in the Amount to be credited to next year’s estimated tax field on screen 4.

Underpayment of Estimated Tax

For underpayment of estimated tax, complete all applicable fields on screen 2220.
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Direct Deposit of Refunds

The IRS requires that Form 8050, Direct Deposit of Corporate Tax Refund, be submit-
ted with an e-filed return in order for a corporate refund to be directly deposited. To
complete this form in Drake, use the DD screen (Figure 5).

Federal Account and State (if same as Federal)

Deposit selection: Federal selection........... | - Statelcity selection................. -
Mame of financial institution RTH Account number Type of account
| [ [~ Checking [~ Savings
Repeat Account Information | | [ Checking [ Savings

Figure 5: Federal section of DD screen (also 8050 screen)

When filling out the DD screen:

* If the federal refund is to go to the account listed, select Yes for the Federal
Account selection; otherwise, select No. (Default is Yes.)

* Ifa state refund is to go to the account listed, select the state abbreviation from the
State/city selection drop list.

* Enter the name of the financial institution, the routing number (RTN), the account
number, and the type of account (Checking or Savings).

* Re-enter the RTN, account number and type of account to verify.

If receiving refunds from different state tax authorities, use the State Account boxes
on the DD screen to indicate where other state refunds should be deposited.

International ACH Transactions

In 2009, state taxing agencies added foreign account questions to their forms to com-
ply with NACHA rules regarding International ACH transactions (IAT); however,
processing AT is not yet supported by any federal or state tax authority. If you were to
indicate that the account was outside the U.S., the state tax authority would automati-
cally ignore the account information and either issue a refund via paper check, or con-
tact the taxpayer requesting the payment of a balance due via check or domestic bank
account. If you indicate that an account is located outside of the U.S., Drake Software
generates a message page instructing you to choose an account located in the U.S.

For more information, see Screen Help on the DD screen and PMT screens.

Electronic Funds Withdrawal (Direct Debit)

Use the PMT screen, accessible from the General tab, to indicate that the balance due
for an e-filed return should be withdrawn (direct-debited) from an account.

Program Defaults and Overrides

By default, the program indicates that the entire balance due (the “Amount owed” sec-
tion of Form 11208S) is to be withdrawn on the return due date. To indicate otherwise,
complete the Requested payment date override field for the applicable payment.

Tax Year 2011 13



Filing an Extension Drake Software User’s Manual Supplement

If the return is e-filed on or before the due date, the requested payment date cannot be
later than the due date. If the return is transmitted after the due date, the requested pay-
ment date cannot be later than the current date.

Required Information

A Withdrawal selection (item 1 in Figure 6) is required if the program is to direct tax
authorities to withdraw funds from the taxpayer’s account.

Federal Account and State (if same as Federal)

1 Withdrawal selection: Federal selection....... hd Statelcity selection.......ccooeee ')

ame of financial institution RTN Account number Type of account ]

| | [~ Checking [~ Savings

At & e b

Repeat Account Information | | [~ Checking [~ Savings

Federal payment amount = Reqguested payment date....= Daytime phone number.= ‘1

Federal:
k%aymemis [ ™ 11208 [~ 7004 [~ Amended 112UE‘D
State: State payment amount......... = Requested payment date....= Daytime phone number.=

Figure 6: Required fields on PMT screen: withdrawal selection (1);
account information (2); specified return (3)

The name of the financial institution, routing number (RTN), account number, and
account type are required. As with the DD screen, the RTN, Account number, and
Type of account data must be entered twice (item 2 in Figure 6).

Finally, the PMT screen must indicate the return to which the payment data applies
(item 3 in Figure 6). Put a check mark in the box of the applicable return type.

Withdrawal from Multiple Accounts

Only one account can be designated for direct debit of funds for payment of federal or
state taxes. To have state amounts withdrawn from an account other than the account
indicated for federal payments, complete the fields in the State Account sections of
the PMT screen.

NDTE Neither the federal nor the state balance due can be paid from more
than one account.

Filing an Extension

Calendar year returns are due on March 15, 2012. By filing Form 7004, an S corpora-
tion can extend the deadline six months to September 15. Fiscal year returns are due
on the 15th day of the third month after the end of their year. Form 7004 extends the
deadline six months.

To file an 1120S extension, use either of the following options:

*  Go to the 7004 screen in Drake and select Generate an extension. Complete any
other applicable fields on the screen.
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* Go to the PRNT screen and select Prepare Form 7004 based on screen 1 data.

Signing the Return

Electronic (PIN) signatures are required for e-filed returns. If e-filing a return, com-
plete all fields on the PIN screen. A return cannot be e-filed if the PIN screen is not
completed, including the title and signature (name) of the officer signing the return.

An 11208 return must be signed and dated by one of the following individuals:

* The corporation’s president, vice president, treasurer, assistant treasurer, or chief
accounting officer

* Any other corporate officer, such as a tax officer, who is authorized to sign

If the return is prepared by a paid preparer, the preparer must complete the required
information and sign the return in the space provided. If it is prepared by an employee
or officer of the corporation, select NONE in the Firm # and Preparer # fields on
screen 1.

To have the preparer’s name and address information displayed on the printed return:

* If'the return preparer and ERO (entered in Setup > ERO) are the same:
— Go to Setup > Preparer(s) and ensure that the Alternative Electronic Signa-
ture box is marked for the preparer.
— Complete the PIN screen for the return.
* If the return preparer and ERO are not the same:
— Go to the PRNT screen for the return and complete the field labeled PIN for
preparer’s alternative electronic signature. The PIN entered should match

the one entered for the preparer in Setup > Preparer(s). (For more informa-
tion, press F1 in this field.)

N[H'E Setup > ERO must still be completed for e-filing. See the IRS instruc-
tions for further details on signature requirements.

Amending a Return

Amended 1120S can be e-filed using Drake Software.

When you amend a return in Drake, the amended information
replaces the original in the data file. Before amending a return, you

EAU‘” DN should archive the original to avoid losing previously submitted data.
For more information on archiving returns, see “Archive Manager” in
Chapter 6, “Return Results,” of the Drake Software User’s Manual:
Tax Year 2011.

To file an amended 11208 return:

1. Go to screen 1 and select Amended return in section H.
2. Make changes as applicable to forms and schedules.
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g

Go to the EF screen and mark the 1120S check box on the left side of the screen.

4. Go to the AMD screen and list the changes that have been made, along with an
explanation for each change. Use a different AMD screen for each line of the
1120S. Press PAGE DOWN to open a new AMD screen.

If amending just the K-1s, go to each applicable K1 screen, select Amended K1, and
make needed changes.

When amending an 1120S return, all K-1s are amended, and the

N[H'E “Amended K-1" box on the return marked, by default. To override this

default, go to the PRNT screen and mark Do NOT check amended
box on Sch. K-1. (See Figure 8 on page 20.)

Additional Information

Schedule B

This section covers Schedule B (Other Information), state-specific information, and
some program overrides.

Enter the accounting method, principal business activity, and product or service on
screen 1. This information (questions 1 and 2 of Schedule B) flows to Schedule B.

Use screen B to answer questions 3—8 of Schedule B. If the S corporation owned,

directly or indirectly, 50% or more of the voting stock of a domestic corporation, click
the B3 link to enter information about the domestic corporation owned. (You can enter
information for up to 15 corporations per B3 screen; to add more, click PAGE DOWN.)

State-specific Information

Resident
State

Other States

Multi-State
Appor-
tionment

The program automatically generates a return for the corporation’s resident state. Use
screen 2 to enter company information as it should appear on the state return.

The company information fields on screen 2 apply for the resident state

NOTES o™

The link to screen 2 now appears under the States tab (or enter 2 in
the selector field and press ENTER).

Company information includes the type of return that applies for state purposes (con-
solidated, composite, controlled group, multi-state) and state-specific dates and num-
bers for identification.

Data for other states must be entered manually in state data entry. To access state data
entry, select the States tab from the return menu and choose a state.

New for 2011: Enter sales, payroll, and property factors on the APPT Multi-State
Apportionment screen (accessible from the States tab or by entering APPT in the
selector field and pressing ENTER). This screen provides one central location for enter-

16
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ing all state apportionment information instead of having to open each needed state’s
screen.

In addition to making data input faster and easier, the new feature provides two new
worksheets: a summary worksheet (SA-SUM~) that can be used for verifying input,
and a reconciliation worksheet (SA-REC) that ties the total of the state amounts to the
federal return figures. These worksheets are available in View mode.

The individual state apportionment screens will continue to be available in Drakell
but will be used to override data entered on the APPT screen. No state apportionment-
related screens will be updated from Drake10 to Drakell.

Drake 2011 - Data Entry (212121212 - PAT'S PACKAGING) *
Screen links
(Sales Payroll | Property | Additional Property | ) «fem——— ]
State Apportionment - Sales Factor
State Selection Required field co - MR v NC
Sales
Outside state to inside state. . 120123 | sa522 |
Within state to within state...__._______/ 112100 | ss02z |
Within state to U.S. Government | | 4
Throwback (nonta | | 4
Returns and Allow; State drop lists 1
QT Y 1Ty ) | 1474 | 2212 | .
Within to within.........o | |
WIthin to S GOV | | | 4
et S S AR T e T A q.\‘w.\..‘...mﬁ

Figure 7: New APPT screens

APPT Screens  The new APPT screen is opened to the Sales tab. Links at the top of this screen take
you to the Payroll, Property, and Additional Property information tabs for each
state selected (Figure 7). These screens and their uses are listed in Table 1:

Table 1: APPT Screens

Screen Information

Sales Select state; enter sales, returns and allowance, and other
income-related information for each selected state

Payroll Enter salary, wage, commission, and labor amounts for
each selected state

Property Enter beginning and ending amounts of common apportion-
ment factors, plus select additional apportionment factors
from drop lists

Additional Property Select additional apportionment factors from drop lists

The Ending amount entered on the Property and Addition Property

N DTE screens in Drakel1 will become the Beginning amount for property on
the APPT screen when the client’s return is updated next year in
Drakel2.
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Contact
Information

Officer
Information

You may enter up to four states on one APPT screen. If you need more than four
states, press PAGE DOWN for a new APPT screen. The same state can be entered more
than once when additional fields are needed.

Select OT Other Reconciliation from the State Selection drop list when using the
reconciliation worksheet. Not every item appearing on the federal return may be sub-
ject to multi-state apportionment. When you select OT, the data entered becomes a
reconciling adjustment amount to aid in tying to the federal return.

Enter as much or as little detail as the states require. If a state does not require any
information to be entered, no information will flow to that state’s return.

Click Screen Help on each tab for state-specific information.

If certain contact information required for state purposes is different from that entered
on screen 1, use screen 2 for the alternative data for any of the following entities:

* Registered office
* Principal place of business

e  “Books in care of” information

Screen 2 also has fields for the name, title, e-mail address, ID number, and telephone
number of the S corporation’s contact person.

Access screen 2 from the States tab or by entering 2 in the selector field and pressing
ENTER.

Screen E, Officer Information, is for state purposes only. Nothing entered on this
screen is carried to the federal return. The link to this screen has been moved to the
States tab (or you can enter either E or OFF in the selector field and press ENTER).

Other Information and Overrides

Use screen 1 to enter the following additional information:

* Resident State — If the corporation has a mailing address in one state but does
business in another, select the state in which the corporation does business from
the Resident State drop list.

* Drake Codes and Overrides — Information on miscellaneous codes, invoice

numbers, and override fields is covered in the Drake Software Users Manual: Tax
Year 2011.

Schedule K: Shareholders’ Pro Rata Share Items

Screen K, which consists of two screens, can be used to enter data for Schedule K,
Shareholders’ Pro Rata Share Items. Note the K fields are primarily adjustment fields.

18
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Press F1 (or use the right-click menu) to see what amounts are adjusted from else-
where in the program.

You can also find information on adjustment and override fields in the

N[H'E Adjustment Worksheet and Override Worksheet, available through the
FAQ screen. Open the FAQ screen, click the Screen Help button (or
press CTRL+ALT+?) and click the links at the top of the window.

Navigation

Press PAGE UP and PAGE DOWN to navigate back and forth between the two K
screens:

¢ Shareholders’ Pro Rata Share Items (Income and Deductions)
* Credits & Credit Recapture & Foreign Transactions

The most commonly used Schedule K items can be answered on the
T”] INC screen. If these amounts are entered there, they do not need to be
entered on the K screens.

Because charitable contributions are separately stated to the share-
holders, there is no “Charitable Contributions” line on the 1120S return.

NDTE Charitable contribution information belongs instead on the Schedule K.
Enter charitable contributions in the bottom section of the INC screen or
in the line 12a - Contributions fields of the K screens. Any contribution
limitation is made at the shareholder level.

Schedule K-1 for 1120S (Shareholder Information)

Use the K1 screen to enter data for Schedule K-1, Shareholder’s Share of Income,
Deductions, Credits, etc.

The program now calculates percentage ownership based on the num-

N[H'E ber of shares owned. (This amount can be overridden on line F of the
K1 screen. Use of the Shareholder’s % of stock ownership field,
however, is not recommended.)

Ownership Changes

Entry of ownership changes has changed in the 2011 program. Previously, ownership
changes were entered on a third K screen. New in 2011, all ownership change infor-
mation is entered on the OWN screen, which is accessible from the General tab of the
Data Entry Menu. To use the OWN screen:

* Enter the date of ownership change at the top of the screen.

* Select the applicable shareholder from the drop list in the Change in Shares sec-
tion. (The drop list consists of the names and ID numbers entered on the K1
screens and is updated automatically).

* Enter the change in ownership as a positive amount for an increase and a negative
amount for a decrease. (See field-level help for more information.)
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* To enter additional ownership changes, press PAGE DOWN.

NDTE See FAQ item “P” in the program for more information on entering own-
ership-change information.

Printed Data A Summary of Stock Ownership worksheet (WK_SOWN) is generated listing all
shareholders and the numbers of stocks owned, along with the changes in ownership.
Because a shareholder’s percentage ownership may change even if the shareholder’s
number of stocks owned does not, all shareholders are listed on the worksheet.

IRS K-1 Codes

A code sheet can follow the printing of each Form 1120S K-1 to help interpret the var-
ious codes used on Schedule K-1. In Drake, this is the 1120SK_1.PG3 sheet. To have
this sheet printed with all K-1 schedules, go to Setup > Options > Form & Schedule
Options tab and mark the Print Page 2 of Schedule K-1 check box. The codes can
also be printed for a specific return by marking the applicable box on the PRNT
screen, and are available from Tools > Blank Forms.

Codes sheets are not displayed in View mode. If the 1120S K-1 is
NDTE selected for printing, it is printed first, followed by the statements per-
taining to that 1120S K-1. These are followed by the code sheets.

The generated Schedule K-1 may include asterisks with letter codes.

*  An asterisk with a letter code indicates that multiple items have that code.

* An asterisk at the bottom of a group indicates that there are more items than can fit
in the space provided for that group and that a statement is attached, or that the
statement is required (as in the case of “other” amounts).

Multiple Shareholders

For returns with a large number of shareholders, you have the option to deactivate cal-
culation and printing of the K-1s while working on the Form 11208S. This option,
which eases the process of reconciling the 11208, is available by going to the PRNT
screen and marking the box under K-1 Items to Suppress (Figure 8).

k-1 ltems to Suppress

[¥ Suppress Sch K-1, K-1 letter, K-1 ATT, and WK_SBAS

[~ Do MNOT check amended box on Sch. K-1 (from Screen 1)
[ Suppress K1_DIST

Figure 8: Check box for suppressing K-1 items (located on PRNT screen)

When the return is ready to be filed, return to the PRNT screen and remove this check
mark before calculating the return.
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Override Fields

It is not possible to override the calculations for a single shareholder. To override cal-
culated data, it is necessary to override the calculated amount on all K-1 schedules.

| M PD RTANT Shareholder overrides should not be done for an S corporation

except in certain circumstances, such as ownership changes.

Foreign Addresses

K-1 Export

If the shareholder has a foreign address, enter Province/State, country, and postal
code information on the Foreign address line of the Shareholder Name and Address
Information section (along with the street address and city in the Address and City
fields). Do not enter anything in the U.S. State or ZIP fields. Conversely, for a U.S.
address, do not enter anything into the foreign address fields

Take the following steps to export a K-1 from an 1120S return into a 1040 return:

1. Ensure that K-1 data is entered in the 1120S and that the 1040 has been created.
(The K18 screen in the 1040 does not have to be created beforehand.)

2. Inthe 11208 return, go to View mode.

3. Click K1 Export in the View mode toolbar. If any K-1s are not eligible to be
exported, that list appears. Click Next to continue; otherwise, the list of K-1s eli-
gible for export appears.

4. Select the SSNs to be exported by marking the boxes to the left of the SSNs.

5. Click Export. The K-1 data will be displayed in the 1040 return in the program.

Basis information for individual shareholders should be entered in the
NDTE 1040 package in Drake; this information cannot be exported from the

1120S package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.

Supplemental Info

Two types of supplemental information can be added to Schedules K-1:

* Supplemental data for all K-1s in a return

* Supplemental data for a single K-1 in a return

To add supplemental information “globally” (to all K-1s), from the Data Entry
Menu, open screen K1G (Global Supplemental Information) and enter the informa-
tion in the Supplemental Information text box. This information will appear on all
printed shareholder K-1s.

To add supplemental information to an individual K-1, open a shareholder’s K1
screen and click the blue Supplemental Info link at the top of the screen. In the Sup-
plemental Information pane (Figure 9), enter information pertinent to this share-

Tax Year 2011
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holder. When the return is printed, this information will appear only on this
shareholder’s K-1.

K1S - K-1 Supplemental Information Statement

K1 Basis Wks Supplemental info 400000066 - Carl O'Hare

Enter global supplemental information for all K-1s on the K16 screen.

Enter specific information for a single K-1 here. This information is added to
the global supplemental information entered on the K1G screen.

Supplemental Information

Note the following information for Carl D'Hare:|

- . -ﬁ‘--*.,w-‘"--\__.-*rm-d--—-ﬂ\ o nandi il A o gt B et |l

Figure 9: In this example, the information entered on the K18 screen appears
only on the individual shareholder’s K-1.

Domestic Production Activities

An S corporation does not take the deduction for Form 8903, Domestic Production
Activities Deduction. Because the deduction is subject to income limitations, this
information must be reported on shareholders’ individual returns. Shareholders use
the pass-through amounts to calculate their eligibility for the deduction.

On the 8903 screen, if the Print K1-8903 for each shareholder box is not selected,

the amounts flow to the K-1, box 12, with codes Q and R. When this box is selected,
the information flows to attachment K-1_ 8903 instead of box 12 on the K-1. Attach-
ment K1_8903 is referenced on a statement. Code P is printed on box 12 of the K-1,

which refers to domestic production activities information.

Review the screen 8903 screen-level help, and the 8903 instructions (accessible
through the Screen Help button on the 8903 screen) to determine when the K1 8903
in needed.

Line 11 (“Income limitation”) of Form 8903 is not applicable for the S

corporation because the income limitation is calculated at the share-
N DTES holder level.

“Form W-2 wages” (on the 8903 screen) refers to the corporation’s W-2

wages paid that are applicable to the Domestic Production Activities

Deduction.

K-1 Cover Letters

K-1 cover letters can be produced to accompany each Schedule K-1 in a return. You
can set up the global option to produce K-1 cover letters for all returns containing K-1
schedules, or you can choose the option on a per-return basis.

Producing To have the K-1 cover letters produced automatically with a// applicable returns, go to
Letters for  Setup > Options. Under the Optional Documents tab, mark the box labeled Include
All Returns  K-1 letter with returns. The signature on the return can be indicated in one of two
ways:

* By completing the Signature and Title fields on the PIN screen
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* By completing the Name and Title fields in the K1L screen (entries here override
entries on the PIN screen)

Producing Ifno default has been set to produce K-1 cover letters with all returns, you can take the
Lettesl's for following steps to generate letters for a single return:
ingle
Return 1. Open the return and go to screen K1L.
2. At the bottom of the screen, enter the name and title of the person who will be
signing the K-1 cover letter.
3. (optional) Mark Do not print entity information ... at the bottom of the screen in
order to prevent the corporation’s name and address from being generated in the
header of the K-1 letter.

To have the corporation’s name and address generated for K-1 letters,
NDTE go to Setup > Letters > Setup > Letterhead and Margins and select
Use Firm Info on Letters.

Once the required signing information has been entered, a K-1 cover letter will be
generated for each shareholder receiving a K-1.

Editing the As with other letters provided by the program, you can edit the text to suit your office
K-1 Letter needs and style.

Review the following sections of the Drake Software User’s Manual:
'|'|P Tax Year 2011 before making changes to letter templates:

- “Introduction to Letters in Drake” in Chapter 2, Installation & Setup
- The “Letter Keywords” section of Appendix C, Keywords

To edit the text of the K-1 letter:

1. From the Home window, select Setup > Letters. The Client Communications
Editor is displayed.

2. Select Open > S Corporation > Sub S K-1 Cover to view the template of the S
corporation K-1 letter.

g

Make any desired changes to the template.
4. Click Save.

For an amended return, the K-1 letter automatically refers to the

N[H'E amended K-1. To edit the letter for an amended K-1, select Open > S
Corporation > Sub S K1 Amended and follow steps 3 and 4 of the
previous procedure.
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Shareholder’s Adjusted Basis Worksheet

Increases
and
Decreases

Annual
Update of
Shareholder
Information

Basis information for individual shareholders should be entered in the

N[H'E 1040 package in Drake; this information cannot be exported from the

1120S package to a 1040 return. Such an import would override limita-
tions and carryovers calculated in the 1040 program.

Use the Shareholder’s Adjusted Basis Worksheet (Basis WKks screen) to calculate a
shareholder's new basis after increases and decreases are made during the current year.
The basis of S corporation stock is adjusted on an ongoing basis (unlike for a “C” cor-
poration, where stock basis remains constant unless additional stock purchases are
made or stock is sold). A shareholder’s beginning basis in S corporation stock is the
original capital contribution.

The Basis WKks screen is accessible by clicking the Basis WKks tab at the top of the K1
screen for a shareholder (Figure 10). (Access the K1 screen from the Data Entry
Menu.)

Schedule K-1 - Shareholder's Share of Income, Credits, Deductions, etc.

K1 Supplerental nfo

Sharehalder Mame and Address Information

L T = O 400001001 TyRe.......... :|'

|Hugh Rogers

"'\M-“::M’W._\_.h. el e il ﬁuhl\*-._.\_r.-,_.‘ P L e R

Figure 10: K1 screen tab for accessing the Adjusted Basis Worksheet

Increases to basis can include additional stock purchases and capital contributions,
separately stated income (including tax-exempt income), and depletion in excess of
basis of property.

Decreases to basis can include distributions of cash or property to shareholders, sepa-
rately stated losses and deductions, nondeductible corporation expenses, and credit
adjustments.

When the program is updated to the next tax year, the end-of-year basis and share-
holder loan amounts are automatically updated to the beginning of the new year. Any
loss/deduction carryover is updated to the beginning of the year and its character
(ordinary loss, section 179 expense, charitable contributions, etc.) maintained. The
program also tracks the amount of debt applied to losses and the total amount of loss
carryforwards.

N[H'E If a K1 screen is marked as final, none of the related screens for that

shareholder are updated for the next year.
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Schedule L: Balance Sheet Per Books

Schedule L is required if the corporation’s total receipts for the tax year or its total
assets at the end of the year is greater than $250,000.

To force the program to print Schedule L even if not required, go to the
NDTES PRNT screen and select Force-print Schedules L and M-1.

With the Trial Balance Import feature, you might not need to use screen
L at all. See “Importing Trial Balance Information” on page 42.

Flow of Information

Many of the entries made elsewhere on the return flow automatically to the generated
Schedule L (for example, inventory information from Form 1125-A). Depreciable
asset information from the 4562 screen and intangible assets and amortization also
flow to Schedule L.

The SCH2 Screen

The SCH2 screen is used to provide detailed information required by the IRS for cer-
tain lines on Schedule L. This screen can be used in place of the actual L screen in
Drake. In other words, if you use this screen for all applicable lines on Schedule L,
you do not need to make any entries on the L screen.

All line selections are carried to the SCH2 screen in next year’s pro-

gram when the returns are updated. Line descriptions are updated, with
N DTES the year-end amounts carried to the beginning-of-year column.

To access the SCH2 screen from the L screen, click the SCH2 Screen

link on lines 6, 9, or 14 (or press CTRL+2).

To create a statement for a line, select a line from the drop list and enter descriptions
and their corresponding amounts. Once the information is entered, or if additional
descriptions are required for the line, press PAGE DOWN to access a new screen.

Statements The total amounts entered on the SCH2 screen do not show up on the actual L screen
in the program. They are, however, printed on the return as applicable, with references
to the corresponding statements.

The type of statement produced by the program depends on the selected line and the
IRS requirements. If a line is required, a statement labeled “STATEMENT” is pro-
duced and is e-filed with the return. If a line is not required, a statement sheet
(“STMT”) is produced and is not e-filed with the return.

Note that an e-fileable “STATEMENT” is referenced in the return, as shown in the
example of Figure 11.
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Select line number from drop list

1 Cash A~
Za Trade Notes and Accounts Feceivable
Zb  Allowance for Bad Debts
3 Inventories
U.5. Government Obligations
Tax-exenpt Securities

Loans to Shareholders

Mortgage and Feal Estate Loans

Other Investments [ATATEMENT)
10a Buildings and Other Depreciable Assets

B B B O T o Ty Vi © S

4
5
=] Other Current iAssets [ STATEMENT)
7
g

)

T T e I S it
Inventories = = @ @ e @ o @ e e m e ae .

LS. government abligations - - « 2 = 2 -
Tax-exempt securities (see instructions)

Other current assets (attach statementy - . (_S_TATEMENT#W) 96,200

Loans to shareholders - @ @« @ @ 2 v e -

- N~ Y

Mortgage and real estate loans - - - - - -
9 COther investments {attach statementy . - - -

10 a Buildings and other depreciable assets .- - -
- gl md@.\mwzqwmm TR — e = gy S PRy

Figure 11: Data entered on the “Other current assets” line will be attached as an
e-fileable statement and referenced on the applicable line of the return.

SCH2 and Typically, one or more SCH2 detail screens are needed for Schedule L items. If you
Trial Balance are using Drake’s trial balance worksheet feature, be aware that data for the SCH2
screens cannot be entered directly into the trial balance worksheet, and it cannot be
imported into the data entry. The SCH2 detail screens must be created apart from the
trial balance worksheet.

When the return is produced, Schedule L reflects both the amounts imported from the
trial balance worksheets (where direct entry was allowed) and the totals of the SCH2
screen amounts.

For more information, see “SCH2 Detail” on page 50.

Autobalance

Autobalance forces Schedule L to balance for both the beginning- and end-of-year
amounts. The program adjusts the unappropriated retained earnings amount on Sched-
ule L by the difference between the total assets and the total liabilities and capital
before the adjustment.

(Example: If Assets = $1,000, and Liabilities and Capital = $900, the program
increases the unappropriated retained earnings by $100.)

The program makes the adjustment due to differences in the balance sheet. These dif-
ferences can come from amounts entered incorrectly but are usually the result of one
of the following causes:

* An asset was deleted from the 4562 screen (Depreciation Detail) instead of being
indicated as sold.

* Beginning inventory amounts were adjusted on screen A, or ending inventory
amounts were entered incorrectly.

26 Tax Year 2011



Drake Software User’s Manual Supplement

Schedules M-1, M-3 (Reconciliation of Books/Return)

*  Amounts were erroneously deleted from or changed on screen L.

To reconcile the differences, it is best to compare the corporation’s beginning and end-
ing balance sheet amounts for the tax year.

To deactivate the autobalance feature for a specific return, go to the PRNT screen and
select Turn off autobalance.

Schedules M-1, M-3 (Reconciliation of Books/Return)

Schedule M-1 is required if the balance sheet’s total assets at the end of the year are
greater than $250,000. Schedule M-3 is required if the balance sheet’s total assets at
the end of the year equal or exceed $10 million.

NOTE

screen and press CTRL+D.

Schedule M-1

If the S corporation is filing Schedule M-3, and there are entries on the
M1 screen, it's best to delete the M1 screen. To do so, open the M1

Schedule M-1 shows all items of income and expense that are not subject to tax, plus
those accounting items that are not income tax items. When required, taxpayers must
reconcile book income with taxable income.

Use the M1 screen to enter book-to-tax difference for Schedule M-1. Book-to-tax dif-
ferences are classified as permanent or temporary, and as favorable or unfavorable.
Examples of both kinds of differences are shown in Table 2.

Table 2: Examples Book-to-Tax Differences for Schedule M-1

Difference

Description

Examples

Permanent

Book or tax items that will never be
reported for book or tax purposes

- Meals & entertainment limitations
- Penalties
- Tax-exempt interest

Temporary

Iltems that will be reported for both
tax and book purposes, but not dur-
ing the same tax year

- Depreciation
- Gains or losses on the sale of
depreciated assets

Favorable

Iltems that reduce taxable income

- Instances in which tax depreciation
amount is greater than book depre-
ciation amount

Unfavorable

Items that increase taxable income

- Disallowed meals & entertainment

Depreciation

and
Amortization
Adjustments

The program may make an adjustment for book-to-tax depreciation (or amortization)
differences. The calculation is done with the following steps. (This procedure refers to
“depreciation” throughout, but it applies for either depreciation or amortization.)

1. The amount reported on Schedule L “Beginning of Year” accumulated deprecia-
tion (line 10b, column a) is subtracted from the “End of Year” accumulated depre-
ciation (line 10b, column c). This is the “book™ depreciation amount.
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2. This “book” depreciation amount is compared to the “tax” depreciation amount.
(The “tax” depreciation amount is calculated from the Forms 4562, including any
section 179 amounts.)

3. The difference between the “book” and “tax™ depreciation amounts is carried to
the appropriate form and line.

* If the “book” depreciation amount is greater than the “tax” depreciation
amount, the difference is carried to one of the following locations:

— Schedule M-1, line 3a
— Schedule M-3, Part III, line 24 (as a negative amount)

— Form 8916-A, line 21 (as a negative amount for assets selected on the
4562 detail screen for COGS)

e Ifthe “tax” depreciation amount is greater than the “book” depreciation
amount, the difference is carried to one of the following locations:

— Schedule M-1, line 6a
— Schedule M-3, Part II, line 24 (as a positive amount)

— Form 8916-A, line 21 (as a positive amount for assets selected on the 4562
detail screen for COGS)

Schedule M-3

Accessing
the M3
Screens

The SCH3
Screen

Any domestic corporation or group of corporations that report on Schedule L of Form
11208 total assets at the end of the S corporation’s tax year that equal or exceed $10
million must complete and file Schedule M-3 instead of Schedule M-1. If the S corpo-
ration is required to file (or voluntarily files) Schedule M-3, it must file Form 1120S
and all attachments and schedules, including Schedule M-3.

The Schedule M-3 section of the Data Entry Menu provides direct access to the fol-
lowing screens:

e M3, M32, and M33 — for Parts I, I1, and III of the Schedule M-3

¢ MB3S — for supplemental statements

* SCH3 — for subsidiary schedules for Schedule M-3 and Form 8916-A
* 8916A — for Form 8916-A, Supplemental Attachment to Schedule M-3

Certain income, deductions, gains, and losses flow from the 1120S to the M-3 in the
program, but all other M-3 data must be entered manually on the M3 screens.

Parts Il and Ill of Schedule M-3 reconcile financial statement net

NDTE income (loss) for the U.S. tax return (per Schedule M-3, Part |, line 11)

to total income (loss) on Form 1120S, page 3, Schedule K, line 18.

The SCH3 screen is similar to the SCH2 screen and is used to provide detailed infor-
mation for Schedule M-3 and Form 8916-A. It can be used in place of the actual M3
and 8916A screens.

For more information on using this type of screen, see “The SCH2 Screen” on
page 25.
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Schedule M-2 (Analysis of Accounts)

NDTE On an 11208 return (unlike an 1120 return), Schedule M-2 is not a rec-

onciliation of retained earnings.

For an S corporation return, Schedule M-2 is the analysis of the Accumulated Adjust-
ment Account. Schedule M-2 information can be entered on the M2 screen and else-
where in the program, but most information is carried to the M-2 automatically. See
“Entering Distributions,” following.

Schedule M-2 represents a corporate picture of the income, losses, and distributions to
shareholders and tracks tax-free distributions and helps determine if excess distribu-
tions might be taxable to shareholders. If a shareholder receives more in distributions
than he or she has in basis, the result might be taxable.

Entering Distributions

Code Section 6037 states that an S corporation return must report the amount and date
of distributions made to each shareholder. The DIST screen is used for entering date
and distribution amounts for Schedule K, line 16d, Distributions. In addition to line
16d, the total from the DIST screen may flow to Schedule M-2, line 7 (subject to lim-
itations) and to the Schedules K-1 based on the shareholder’s ownership percentage.
Schedule K-1 distribution information is displayed on the K1 _DIST worksheet pro-
duced with the return.

Column A, Accumulated Adjustments Account

The Accumulated Adjustments Account (AAA) column generally reflects the S cor-
poration’s accumulated undistributed net income after 1982. Non-dividend distribu-
tions flow to Schedule M-2 from Schedule K, line 16d. An entry in the Non-dividend
distributions field (line 7) of the M2 screen adjusts the amount from the K screen
(subject to limitations; see balance-sheet examples on the following page).

Distributions reported on line 7 flow differently from the amount entered on the DIST
screen. (See the previous section, “Entering Distributions.”) The distributions are lim-
ited following the ordering rules under Reg §1.1368.2.

T”J See Form 1120S instructions for more details and examples.

These rules are for Schedule M-2, column a:

* Line 1 balance — The balance at the beginning of tax year, line 1 is either
zero or the balance carried forward from line 8 of the previous year. Due to
prior-year net losses and reductions, the amount on line 1 can be negative.

* Changes to AAA — The AAA is increased for ordinary income from page 1,
line 21 (line 2) and other additions listed on line 3. The AAA is then
decreased for any loss from page 1, line 21 (line 4) and other reductions listed
on line 5.
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Important
Note about
the AAA

* Reduction of AAA — Once these adjustments are made, the AAA is reduced
by ordinary distributions on line 7, but not less than zero. Thus, if the distribu-
tions are $20,000, but the net amount on line 6 is $10,000, line 7 is limited to
$10,000. If line 6 is a negative number, then line 7 will be zero (in this exam-
ple). To allow an amount on this line would take the AAA to a larger negative
number. (That is, even more below zero than it really is).

Schedule M-2 ltem Amount
Ling 1 Balance at beginning of tax year ($11,786)
Lines 2 &3 Crdinary income and other additions $538 440
Lines4 &5 Loss and other reductions ($459)
Ling 6 Combine lines 1-5 $46 165
Line 7 Distributions {total $60,000) ($46,165)
Line & Ealance at the end of tax year $0

The rules from the preceding chart apply when the net adjustment for lines 2 through 5
is positive. When the net adjustment for lines 2 through 5 is negative, the ordering
rules are switched and AAA is decreased by ordinary distributions (but not below
zero) before the net negative adjustment for lines 2 through 5.

Sch. M-2  Item Amount

Ling 1 Ealance at beginning of tax year 11,786
Line B Met negative adjustment (lines 2-5) ($57.951)
Line 7 Distributions {total $60,000) ($11.786)
Lined EBalance at end of tax year ($57.951)

A corporation can make distributions greater than the amount on line 6 of the M-2, but
those distributions could be taxable to the shareholders. Enter distributions on the
DIST screen; this way, the amounts flow automatically to Schedules M-2 and K-1 but
are limited based on the rules described previously. (For more information on the
DIST screen, see “Entering Distributions” on page 29.)

Line 7 is limited to the lesser of the amount for line 7 or the positive amount from line
6. If line 6 is negative, line 7 is then limited to the positive amount on line 1. If line 1
and line 6 are both negative, line 7 is completely disallowed on the Schedule M-2.
Distributions are entered on the DIST screen to be reported to the shareholders,
regardless of the Schedule M-2 limitation.The AAA cannot be negative as a result of
distributions, but it can be negative if it arises from losses.

Column B, Other Adjustments Account

Use column b to enter any amounts you want printed in the corresponding column in
the printed return. Officer life insurance and applicable tax-exempt income flows to
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Schedule M-2, column b (“Other adjustments account™), line 5. All other amounts
(such as expenses) must be entered manually on the M2 screen.

Column C, Undistributed Taxable Income Previously Taxed

The total of column ¢ cannot be negative. This column is active in an 1120S only if the
entity was ever a “C” corporation (thus having earnings and profit (E&P)) or if it was
a pre-1983 S corporation. By design, Drake does not allow negative numbers in col-
umn c.

If a corporation becomes an S corporation and has net operating losses (NOLs), the
NOL is not generated for the return because it cannot be carried to an 1120S (the IRS
does not want the NOL to be used by the shareholders to offset income); it either runs
out within the years allowable for the NOL by statute or is used if the S corporation
terminates its ““S” status within those years.

Rental Activities

Income and expenses for rental real estate properties appear on Form 8825, Rental
Real Estate Income and Expenses of a Partnership or an S Corporation. To make
entries in Drake, use the 8825 screen.

If there are multiple 8825 properties, press PAGE DOWN for a new 8825 screen. Use
one screen per rental property. If a return has more than one 8825 screen, the program
reports each property’s information on a separate column of Form 8825 (up to eight
properties can be included on a form). Data from all 8825 screens are transmitted to
the IRS when the return is e-filed.

N[H'E Special steps are required if using the trial balance worksheet for multi-

ple rentals. See “Rental Expenses” on page 51.

Line 14, Depreciation

Carrying
Information
to Form 8825

If the program is calculating depreciation (entered on the 4562 screen) for the property
listed on Form 8825, do not enter the depreciation on the 8825 screen. Depreciation
should be entered only if it is figured outside of the Drake program, and then the net
results should be entered on screen 8825. The amount entered on line 14 is added to
the depreciation calculated from the 4562 screens.

NDTE Form 4562 is required for assets placed in service during the year.

To indicate that the information should be carried to Form 8825, select 8825 from the
For drop list on screen 4562. If there are multiple 8825 screens, use the Multi-form
code box. For information on using the Multi-form code box, see the Drake Software
User's Manual: Tax Year 2011.
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Form 4562 For 8825 »| \ 11208, COGS, 8825, RENT, F 4
Multi-form code: 3 (1-999; 1 is assumed if left blank)
Date
Description Acquired Cost/ Basis
|rental units |o1-01-2010 | 554433

.., Federal te
. ..ﬂ,n?_.‘h‘.ﬂ_m-‘#“\.khv‘#\.-l.w SRy D A ‘;‘ﬁ

Figure 12: In this example, the program will carry the 4562 information
to the third 8825 screen created.

Any depreciation information entered on the 4562 screen is carried to the correct
Form 8825, based on the form and multi-form code selections at the top of the 4562
detail screens.

When selecting a multi-form code, note that the code should refer
to an 8825 screen—not the 8825 form. For example, data from
the third 8825 screen will be generated on the first Form 8825. To

|M PDRTANT associate an asset with that information, you would enter a 3 for
the screen (not a 1 for the form) in the Multi-form code box. For
more information on Form 8825, see “Viewing Rental Activity
Information,” below.

Line 15, Other Expenses (list)

Enter meals and entertainment (subject to 50% limit) in the appropriate field on line
15 of the 8825 screen. To enter additional other expenses, begin typing into the Addi-
tional other expenses field to open a Detail (CTRL+W) Worksheet. Enter descriptions
and amounts on this worksheet.

A statement from each 8825 property is printed with the return and is submitted to the
IRS when the return is transmitted.

Use the K1P screen to enter rental income the S corporation receives on a K-1. This
amount is carried to Form 8825, lines 20a and 20b. No entry is required on the 8825
screen.

Viewing Rental Activity Information

Rental activity data is viewed on the 8825 forms and accompanying statements.

* 8825 Forms — The two-page Form 8825 can contain information for up to
eight rental activities. Each Form 8825 in View mode contains up to eight
rental activities. If more are entered, a second Form 8825 is created.
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11205EF

11205
11205 P52
11205 P53 Rental activities #1.8
n20s.Pe4 L~ Rental activities #1-
aas €|
825 ——— | Rental activities
STATMENT starting at #9
WK _M2

FOLDR
FILEINST
LETTER
PRIVACY
BILL
SUMMARYS
COMPARES

Figure 13: Multiple 8825 pages are created if more than eight rental activities.

The Form 8825 in View mode consists of one or more pages (depending on
the number of rental activities) listing up to four rental activities per page. If
more than four rental activities are entered, scroll down to the second page of
the Form 8825 when viewing.

* 8825 Statements — Statements are titled STM_8825_ XX, where XX equals
the instance of the 8825 screen. (For example, the statements for the first and
second 8825 screens would be labeled STM_8825 01 and STM_8825 02,
respectively.) There are also 8825 attachments (8825 _ATT) for other report-
ing information.

Credits and Adjustments

Certain credits require an adjustment to either income or expenses. The program car-
ries the required adjustments to the appropriate line of the return and to either Sched-
ule M-1 or Schedule M-3.

Manually reducing the expenses or deductions or increasing the income for these
credits causes the return to be out of balance.

Adjustments are made to other income for the credit amounts for the following cred-
its:

e Form 6478, Alcoholic and Cellulosic Biofuel Fuels Credit
* Form 8864, Biodiesel and Renewable Diesel Fuels Credit
* Form 8912, Credit to Holders of Tax Credit Bonds (interest income)

Adjustments are made to the appropriate deduction or expense for the credit amounts
for the following credits:

*  Form 5884, Work Opportunity Credit
* Form 6765, Credit for Increasing Research Activities
*  Form 8820, Orphan Drug Credit
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Elections

Form 8845, Indian Employment Credit

Form 8846, Credit for Employer Social Security and Medicare Taxes Paid on Cer-
tain Employee Tips

Form 8881, Credit for Small Employer Pension Plan Startup Costs

Form 8844, Empowerment Zone and Renewal Community Credit

Form 8912, Credit to Holders of Tax Credit Bonds

Form 8932, Credit for Employer Differential Wage Payments

Form 8941, Credit for Small Employer Health Insurance Premiums

The ability to make certain tax elections is included in the business packages. Elec-
tions are selected from the Return Elections section of the ELEC screen (Figure 14).

Description......ooooee |

Cost, basis, amount, years.........
Date oryear-ending..........ccocoo.o....
Other cost, basis, oramount......
Other date or year-ending............
City. |
COUNtY. o |

TR A T i g AR e SR e i e A A A s Bttt P

Return Elections

Election. ... | ﬂ

=

Figure 14: Return Elections portion of ELEC screen

Making an Election in Drake

To indicate that the S corporation is making an election:

1. Open the ELEC screen (accessible from the Miscellaneous tab of the Data Entry

Menu).

2. Make a selection from the Election drop list.

Date oryear-ending.....................

Return Elections

Election. ... ﬂ ?
o 01 - General Election Statement
DESCrptON. ..o 02 - Capitalize and Amortize Circulation Costs over 3 Years
Cost, basis, amount, years....... 03 - Capitalize and Amortize Research and Experimental Expenditures
04 - Capitalize and Amortize Intangikle Drilling and Development

st gttt Lngh SERLIMLIZE, 200 BOTE1ZE SRR CAORIERIN CORE D g e ssnt i o

Figure 15: Election drop list

3. Complete all other fields as applicable. Press F1 in any field to learn if a field is

required for your selection and the type of information that may be needed. For
example, the help text for the Other date or year-ending ficld shows that the
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field is required only for election options 15, 27, 28, 29, and 31, and it explains
what, specifically, should be entered for each of these elections.

"

Drake Software - Data Entry - Help EI_IéJ

Other Date or Year-Ending (direct entry)

Enter any additicnal date or year ending information required
for the selected eletion.

The description field is used on the following election statements
for this package:

S5TM # Tze:

-1

Date of Occurrence
Shareholder's signature date
Officer's signature date

C Corp tax return ending date
31 Shareholder's tax year

(SR

[r

s et i dnn i AP ek e i Bl gaten, o F

Figure 16: Help text for Other date or year-ending field on ELEC screen

If the election option you selected is not listed in the help text for a field,

NDTE then that field should be left blank. For example, if you chose election

01 (General Election Statement), you would not need to enter any-
thing into the Date or year-ending field (help text in Figure 16).

To open a new ELEC screen for an additional election, press PAGE DOWN.

Election Statements

Once an election is made and the return is calculated, the election information is pro-
duced on a statement referenced “STM ELXX,” where “XX” is the number of the

election. For example, election 01 (General Election Statement) is generated as “State-
ment ELO1.”

The election statement includes the election title, election wording, and any additional
information required for the election, such a date or amount.

Entries for certain fields are sometimes included in the actual election statement; other

times, they are included as separate lines. Signature lines are printed as needed on
some statements.

Making Changes on the Fly

Use the PRNT screen to override program defaults.

Suppressing/Forcing Items

1120S Items

To suppress the printing or production, or force the printing or production of certain
documents, go to the PRNT screen and select the desired options. Many “on-the-fly”
changes override the options established in Setup.

These items can be “forced” (forcing the program to generate the item) on a return:

¢ Schedules L and M-1
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K-1 Items

*  Form 4562 (Depreciation and Amortization)

* Next-year depreciation listing

* “Inactive return” printed on first page of the 1120S

* Preparer and officer signature on printed copy of return

The following 11208 items can be “suppressed” (kept from being generated) on a
return:

*  Schedule M-2
¢ WK M2 (Retained Earnings Reconciliation Worksheet)

¢ Form and worksheet references

Form and worksheet references are for the benefit of the preparer and
client but are not required for the tax return. References appear on tax

NDTE forms to clarify which worksheets (available in View mode) correspond

to which calculations, and which forms/screens certain amounts are
carried from.

The following K-1 items can be “forced” (forcing the program to generate the item)
on a return:

* Shareholder’s adjusted basis worksheet (WK_SBAS)
¢ K-1 codes (page 2 of the Schedule K-1)

The following K-1 items can be “suppressed” (kept from being generated) on a return:

* Related documents: Schedule K-1, K-1 cover letter, K1 ATT worksheet (for K-1
statement overflow), and shareholder’s adjusted basis worksheet (WK _SBAS)

* Marking of “Amended K-1” box on printed Schedule K-1
e KI1-DIST worksheet

Overriding Other Setup Options

Filing instructions and envelope coversheets can be either forced or suppressed from
the PRNT screen to override the global setting in Setup.

The PRNT screen also includes options to disable autobalance (see “Autobalance” on
page 26), calculate the Form 2220 penalty, and prepare an extension (Form 7004)
based on the data entered on screen 1 (see “Filing an Extension” on page 14).
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Electronic Filing

Steps for e-filing Form 11208 are the same as for e-filing Form 1040, with the excep-
tion of bankruptcy returns, which must be paper-filed.

S corporations with $10 million or more in total assets that file 250 or
more returns a year are required to e-file their Form 1120S returns.

NDTES Every 1099, W-2, 940, and 941 form that is filed is counted as part of
the 250-return threshold. For example, if a corporation filing an 1120S
return also files 150 W-2 forms, each W-2 would count as a separate
return within the 250-return threshold.

Calendar year returns are due on March 15, 2012. Fiscal year returns are due on the
15th day of the third month (two and a half months) after the S corporation’s year end.
Returns can be e-filed after these dates; however, if an extension has not been filed,
penalties and interest are applied.

Additional Return Types

Short-year returns, 52—-53-week year returns, and inactive returns can all be e-filed
using Drake. For information on how to indicate a short-year return in Drake, see
“Short-Year Returns” on page 5. Information on e-filing 52-53-week returns and
short-year returns is provided in the following sections.

Electing a To elect a 52-53—week year, a new entity (one that has never filed a return) must enter
52-53—-Week data on both screen 1 and the ELEC screen.
Year (Initial
Return) To electa 52-53—week year for any entity:

1. In the If not calendar year section of screen 1, enter the Fiscal year begins and
Fiscal year ends dates. Use MMDDYYYY format, as shown in the example in
Figure 17.

2. Mark the 52-53-week tax year box.

If not calendar year
Fiscal year begins............... 09-25-2011

Fiscal yearends......_._.. 09-26-2012

v 52-53 week tax year ELEC

Figure 17: In this example, the fiscal year begins 09/29/2011 and ends 09/26/2012
(the Wednesday closest to the end of September), giving the entity a 53-week year for 2011.

An entity that has filed returns in the past must complete only steps 1
NDTE and 2 of this process. An entity that has never filed a return before must
continue with steps 3 through 6.

3. Click the ELEC link to open the Election Options screen (Figure 18 on page 38).
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Election Options

52-53-Week Tax Year Election
1 Month inwhich new 52-53-week tax year ends...........

2 The day ofthe week on which the tax year always ends..... :I'
B R e (L= oL L= L= L =TT

Figure 18: Elections for 52-53-week tax years

4. For line 1, select the month in which the 52-53—week year ends for the current fis-
cal year. (01 = January, 02 = February, etc.)

5. For line 2, select the day of the week the tax year always ends.

6. For line 3, enter the actual date that the tax year ends (the same date entered in the
Fiscal year ends field on screen 1).

Once a 52-53-week year is selected, the entity must use that account-

NDTE ing period every year. To change accounting periods, the entity must
submit to the IRS Form 3115, Application for Change in Accounting
Method.

In subsequent years, only the 52-53—week tax year check box on screen 1 must be
marked; the program automatically updates the dates.

Inactive Entities that are inactive but are still required to file returns may e-file inactive returns
Returns in Drake. To indicate that a return is inactive:

1. Go to the PRNT screen, accessible from the General tab.
2. Under Items to Print, mark the Print inactive return box.

When the return is calculated, the program displays the words “Inactive Return” on
the main form of the return (specifically, on lines 1c¢ and 2). Zeros are displayed where
required by the IRS in order for amounts to be properly included in the e-file data.

NDTE All EF messages must be cleared in order to e-file an inactive return.

For detailed instructions on e-filing returns in Drake, see Drake Software User s Man-
ual: Tax Year 2011.

Common Error Codes

If one or more of the following IRS error reject codes is generated when e-filing an
11208 return, the preparer must contact the IRS for further information.The IRS
e-Help Desk telephone number is (866) 255-0654.

* Reject Code 239 — Filer’s TIN and Name Control in the Return Header must
match data in the e-File database unless Form 1120S, Item H (2), Name Change
box is selected.

* Reject Code 905 — Electronic Filing Identification Number (EFIN) in the Return
Header must be listed in the e-File database and in accepted status. If you get this
reject code, you must update your e-file application to include the 1120S return
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type (Figure 19). This can be done at the IRS website or by calling the IRS e-file
Help Desk at (866) 255-0654.

4 Check the individual and/or business form types you will e-file for:

[Jos0  [Jo41 [ 1990 W] 1040 L]1ETD

[11041 W] 1065 [11120 POL [] state Ack

Check the 1120 box for 1120 and 1120S. Check the 990 box for
990, 990-EZ, and 8868. See instructions for additional informaticn
on check boxes State Ack and ETD.

Figure 19: The 1120 box must be marked in order to e-file Form 1120S.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed
appraisal statement. In some instances, the IRS requires that a document be attached
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be printed,
scanned into the computer (or “saved” as a PDF document), and attached to the return
in order to be e-filed with the return.

You can attach PDF files to federal S corporation 11208 returns for e-filing. The PDF
Attachments screen is accessible from the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF document to be attached
2. Informing the program that a PDF document will be sent with the return
3. Attaching the PDF document for e-filing

These steps are described in the following sections.

Creating a To create a PDF file:

PDF File
1. Scan the document to be attached to the return.
T”] It's a good idea to use the DDM scanning feature for this step.
2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.
Many types of documents (for instance, documents created in Microsoft
NDTE Word) can be printed or “saved” as PDF documents if you have a PDF
printer (such as Adobe Reader) installed.
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Adding PDF  To indicate in the software that a PDF document will be sent with the return:
Documents
in Drake 1. Open the return in Drake. From the Data Entry Menu, click PDF Attachments

(or type PDF in the selector field and press ENTER).

K1 Sehenile Ry Shareholder Information 7T RN - sigitaturg T e
K1G  Global Supplemental Information DD Direct Deposit
PMT  Electronic Funds Withdrawal
Schedule L Balance Sheet i ide
L Assets PDF  PDF Attachments
L2 Liabilities and Capital
SCHZ2 Balance Sheet Subsidiary Schedule FAQ  Freguently Asked Questions

PRNT Print Options

Gter Screen, State, or City Code:  |FDF )

Figure 20: Select PDF Attachments, or type PDF' into the selector field and press ENTER
2. Fill out the columns on the PDF Attachments screen. See Table 3 for examples.

Table 3: PDF Attachment Window Columns

Name of Column Description Examples
Reference Source Name or number of regulation, - IRS Pub xxx-1.4
publication, or form instruction that | - Form Instructions for 1120S

makes attachments necessary

Description Description of form or documentto | - Title of house on Oak Street
be attached - Appraisal of Lot 1234

File name Distinctive, easily recognizable file | - TitleHouseOakSt.pdf
name, followed by “.pdf’ - AppraisalLot1234.pdf

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF document is attached, the program generates an
EF message page regarding the attachment when the return is calculated.

Attaching To attach a PDF file to a return:
Documents
to the Return 1. From the return, click View. If anything was entered in the PDF Attachments

window (see “Adding PDF Documents in Drake,” previously), there will be two
PDF-related items in the View/Print window:

* An EF Message (item #1 in Figure 21)
* An Attach PDF button on the toolbar (item #2 in Figure 21 on page 41)
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=

Data Entry Print Setup Archive Email Refrezh  BasicView K1 Ewpolt  Aftach PDF H-e-lp

e s B2 O Y ﬁj 6'1

o

Select Forms to Yiew/Print ( 2 )
All Forms l Setz ] 1 ] Federal ] Wwiork sheets ] MHotes/Messages Mizzourn ] Morth Carolina ] Ohio ] Pennsylvania
P 11208 U.S.Income Tax R
Form - Do not file this form
Department of the Treasury attaching Form 2553
L Internal Revenue Serice, }See s
PP T . - P P

Figure 21: The Message file and the Attach PDF button

Click the Message file to view EF messages, including information on how to
attach the required documents to the return.

Click the Attach PDF button. The EF PDF Attachments window displays the
information entered on the PDF Attachments window in data entry. A red X
means the document has not yet been attached; a green check mark indicates an
attached document.

,
Drake 2011 - EF PDF Attachments - [

Required PDF Attachments
The lizt below containe POF Attachments that are required for electronic filing. Select an item from the list and click
‘Browze' to locate the azzociated POF file. ltems with a green check mark. already have the PDF file. ltems with a red %'
are mizzing the required POF File.

| Reference Description Required PDF FileMame
(% Form 11205, Bo G Fom 2563 FORM 2553 PDF
e 31151l Line 20 Proposed Change Diocuments PROPOSEDCHANGEDOCUMEMNTS . FDF
@ Inztructions Tax Form Selections T&: FORM SELECTION.FDF
I @ MO-MRS MO-MAS MOMRESIDENT SHAREH... MOMRS.FDF
@ HMO-MRS MO-MAS MONRESIDENT SHAREH...  MOMRS.PDF
hﬁnumwh*\ﬁ - e,

Figure 22: The EF PDF Attachments window

Click the row of a document to attach.
Click Browse.

Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a
completed return, recalculate to clear the EF Message. The return is now ready to be

e-filed.

Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and
scanned back into the computer to be attached to the return. For example, if Form

2553, Election by a Small Business Corporation, is present in an S corporation return,

message 1513 is generated when the return is calculated.

Tax Year 2011
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1513 ATTACH FORM 2553: The check box for "Attaching Form 2553 as a PDF
document" on screen 1 has been marked, but no Form 2553 has been
attached. Form 2553 must be prepared and attached before the return
can be e-filed.

To prepare Form 2553 for attachment:

. Ensure that the 2553 screen has been completed in data entry.
Calculate the return.

In View/Print mode, select and print Form 2553.

. Have all shareholders sign the form.

=Wl

To attach the signed Form 2553 to the return:

1. Scan the signed form and save it as a PDF document.

2. Go to View mode of the return.

3. Attach the scanned PDF document to the return using the PDF icon
at the top of the screen.

For detailed instructions on attaching this form to a return, go to
the FAQ screen and click "Attaching Form 2553 as a PDF Document."

N A et e R 4---'*-*‘..\1,.__?._”*-\-‘ gl A I ... g A e gl A gt et
Figure 23: EF message page
As shown in Figure 23, the EF Message states that attachments are required. You

would then need to obtain or complete the statements, scan them into the computer,
save them as PDF documents, and attach them to the return.

Importing Trial Balance Information

Drake’s trial balance import feature allows data to be imported into an 1120S return
from a trial balance worksheet. The trial balance template and importing function has
the following benefits:

¢ Eliminates the need to duplicate entries
* Reduces data entry errors by automatically importing data to the correct fields

* Allows preparers to merge basic accounting functions with tax preparation

N[H'E A flow chart of the trial balance importing process is available as an

appendix at the end of this manual.

Preparing to Use Trial Balance Import

The trial balance import function can be used only on returns that were created in
Drake 2008 or later. If you haven’t already, create a client file in Drake or update an
existing client file from the prior year. Like several other functions of the tax software,
this new feature requires Microsoft Excel (version 2000 or later).

In addition, take these actions to ensure the trial balance import works properly:

* Enable Macros — The trial balance import function uses macros in Microsoft
Excel. Check your Excel settings to ensure that macros are activated and that
macro security is set to “medium.” To do so, go to Tools > Options in Excel and
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select the Security tab. Click Macro Security and select Medium, then click

OK.
In Windows 7 and in Microsoft Vista, click the Office button in the upper
left and then click the Excel Options button at the bottom of the win-
NDTE dow. Next, select Trust Center from the list at left, then click the Trust

Center Settings button. Select Macro Settings from the list on the
left, then choose Disable all macros with notification. Click OK.

Disable Autobalance — (optional) When autobalance is disabled, the program is
prevented from automatically adjusting the year-end retained earnings or capital
amounts, thus allowing you to see any discrepancies in the balance sheet. To dis-
able autobalance, go to the PRNT screen and select Turn off autobalance.

Calculations and Other Options
[+ Turn off autobalance

[ Calculate Form 2220 penalty

[~ Prepare Form 7004 based on screen 1 data

For an extension to include payment information, screen 4 may also
need to be completed.

Figure 24: Disable autobalance in the
Calculations and Other Options section of PRNT screen

Force Schedule L — By default, the program does not display the balance sheet
amounts on the return if the entity does not meet the filing requirement. If this is
the case, you must override the default setting in order to have the amounts shown
on Schedule L. To force the Schedule L amounts to be printed, go to the PRNT
screen and select the Force-print Schedules L and M-1 box.

Items to Print
¥ Force-print Schedules L and M-1
[ Print Form 4562

[~ Print next-year depreciation listing
[ Printinactive return

Figure 25: Force Schedule L box for 1120S package

N[H-E Wording of this option varies by return package. The example above is

of the Force-print Schedules L. and M-1 box for an 1120S return.

Check for Detail Worksheets — The trial balance import allows only those
detail worksheets required by the IRS. Check updated returns for detail
(CTRL+W) worksheets that are nof required. For example, the IRS does not
require a detail worksheet for the Gross receipts field on the INC screen; if a
return has a detail worksheet for that field, the trial balance will not be imported
correctly into the return. Detail worksheets are indicated by red shading, as shown
in Figure 26 on page 44.
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Income and Common Schedule K Items

Form 1120-5 - Income

1a Merchant card and third-panty payments . e
1b  Gross receipts or sales notreported on line 1a
1d Returns and allowances plus any "cash back™ included on line 1.

2 ot Of QO0AS B0l e Screen A
-\"":l""""w*r{'arﬂ-‘k R *x--.—-# N q-.,“_#nﬂ"—ﬁﬁl—.ﬂl“—ﬂ\lqn_-—q..u,“_,..nd

Figure 26: Example of an “unnecessary” detail worksheet

Remove unnecessary detail worksheets prior to import. See “Detail Worksheets”
on page 46 for more information on using detail worksheets in the trial balance.

Preparing Financial Data for Import

To prepare the financial data for importing into the return, the data must be entered
into Drake’s specially designed trial balance template. Once this information is
entered and saved, it can be imported into the return.

Opening a  The first step in preparing financial data for importing is to open a trial balance tem-
Template plate for the return and enter the financial data.

To open a trial balance template for a return:

N 1. Open the return to the Data Entry Menu.

-

Click Import > Trial Balance Import in the menu toolbar. The preliminary Trial
Balance Import dialog box is opened.

3. Click Create New or Open Existing. If opening an existing file, click Open after
selecting the correct file.

Impaort

4. 1f a Security Warning box appears, click Enable Macros.

In Microsoft Vista and Windows 7, you will see a Security Warning
NDTE message with an Options button. Click Options to open the Security
Options dialog box, then select Enable this content. Click OK.

The trial balance template is displayed in Microsoft Excel.

Naming Whenever a new template is opened, the tax software assigns it a default file location
Convention  and name. Trial balance templates are saved in the TB folder of your Drakell soft-
ware. The file name consists of the client name as entered in Drake, plus “TB” for

“trial balance,” plus the “.xls” suffix assigned to all Excel files, as shown in Figure 27.

\\Drakell\TB\EntityName|TB|.[x1 s]

N\

File location Name of client "TB" indicates Excel file
trial balance file extension

Figure 27: Example of trial balance template file name
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To change the name of a file in Excel, select File > Save As (in Microsoft Vista and
Windows 7, click the Office button in the upper-left corner and select Save As) and
assign the new name.

If saving a trial balance to a different location, make a note of where
NDTE you're storing it. The program automatically looks in the default direc-
tory.

Template The trial balance template consists of three title rows and six columns. The Entity
Structure  Name and Year End title rows can be edited; double-click a row to change the title.
Columns are described in Table 4.

Table 4: Trial Balance Template Columns

Column Description
Account Title Title of account
Debit/Credit Debit and credit amounts
Import to Screen and line in Drake to which the debit or credit

amount is imported

Reported on: Form, Page, Location of the amount on the printed return
Sch, and/or line

Other information Additional details for preparers; see “Details for Pre-
parers” on page 49.

Displayed at the bottom of the trial balance worksheet are the calculated amount for
Schedule M-1, line 1; the credit and debit totals; and a cell showing whether or not the
balance sheet is out of balance and, if applicable, the out-of-balance amount

(Figure 28; see also Figure 31 on page 47).

T R E L U
Salariés and wagds - shareholder employées

;'w'
Wiaste removal $0
O
6&'{ Income {Lassi= Schedule M-1, line 1
$100,600
(2

@als F549,350 $549 5504

L — 3

\OUT OF BALAHCE? 30

Figure 28: Schedule M-1 amount (1); totals (2); and indication of balance (3)

Following are instructions and guidelines for using the trial balance template to
assemble financial data for importing into data entry.
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Entering Financial Data

When a new trial balance file is opened for a return, all debit and credit amounts are
zero ($0). All data must be entered manually into the template.

Some data cannot be imported with the trial balance and must be
NDTE entered directly into the data entry fields within the program. For more
on these categories of data, see “Special Conditions” on page 49.

Direct Entry  Most cells in the trial balance worksheet are view-only. In a new template, editable
debit and credit cells are indicated by a dollar amount ($0) and are not gray.

Detail Some cells require more detail than can be entered on a single line. These cells are
Worksheets indicated by buttons. (If these cells do not work, you may need to enable them; see the
Note in “Opening a Template” on page 44.)

1

S 80| 3line7 Form 1120, pi
\ §0 does not carry detail requiredﬁ
<’1 §0 TES IO TETTY | detailrequire’
70 B ook Income D etail (M-1) \ requires detaike
“ 50 Other Income )' rETLiEs d?'
i A line 2 Farm 1120, Stk

Figure 29: Example of cells that require worksheets

Click a worksheet button to open a worksheet in a new tab. Figure 30 shows an exam-
ple of the “Other Income” worksheet.

46 Tax Year 2011



Drake Software User’s Manual Supplement Importing Trial Balance Information

Statement Required - Other Income
Form 11208, page 1, line 5. INC lines 1-7

Line Description Amount Import to:
1 |Amount of credit for tax on fuels (Form 4136) I 300 INC, line 1
2 |Interest income on receivables 30 INC, line 2
3 |Recoveries of bad debts deducted in earlier years 50 INC, line 3
4 |Section 481 adjustments 50 INC, line 4

5 |State tax refund (cash basis) 50| INC, line 5
6 |Taxable income from insurance proceeds B e
7 |Other $ Other Income Detail
Total other income 50
()
2)

Glick to return to TB D
4 "(S%S_%jother Income ¥ I
———

Figure 30: Trial balance worksheet for “Other Income”

To return to the previous worksheet, click the TB tab (labeled “1” in Figure 30), or
click the Return button above the worksheet tabs (labeled “2” in Figure 30). Note that
a detail tab (the “Other Income” tab in Figure 30) might include one or more detail
worksheets (labeled “3” in Figure 30).

Do not create detail worksheets in data entry if the trial balance work-
NDTE sheet does not provide an equivalent detail worksheet, or the trial bal-
ance will not be imported correctly.

Totals Totals are displayed at the bottom of each worksheet. If credit and debit columns are
out of balance, the worksheet highlights the out-of-balance amount (Figure 31).

R . e e R -

T e

Totals 512,500 54100

_——— ——

OUT OF BALANCE? 53,800

> M| SBSTB ¥

Figure 31: Out-of-balance amount is highlighted if columns are out of balance.

In addition to credit and debit totals, the main trial balance worksheet shows the net
income (loss) to be calculated for line 1 of Schedule M-1 after all entries and adjust-
ments are made in the software.

NDTE The data cannot be imported if the worksheet is out of balance.
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Saving a File

To save a file, click the Save icon or select File > Save from the menu bar. (In
Microsoft Vista and Windows 7, click the Office button in the upper-left corner and
select Save.) To re-name a file when saving, select File > Save As. For more informa-
tion on file names in the trial balance program, see “Naming Convention” on page 44.

Importing Data into a Return

Import

Once a trial balance worksheet has been set up for a client in Drake, the trial balance
information can be imported into the program and calculated into the return.

Not all trial balance data can be imported directly into a return. For
information on program limitations, see “Special Conditions” on

NOTES ~ pase 4

If you are already in the Trial Balance Import tool for the selected return,
go to the Trial Balance Import window in Drake and start at Step 3 of
the following procedure.

To import a trial balance into a return:

g

6.
7.

Open the return to which you will import the trial balance information.

Click Import > Trial Balance Import from the menu toolbar. The preliminary
Trial Balance Import dialog box is opened.

Click Next.

Enter or select the trial balance file to be imported. If necessary, click the button to
the right of 1. Import File Name to browse to the proper folder. By default, each
trial balance file is an Excel (.xls) file showing the client name and ending in
“TB” for trial balance, as shown in the example in Figure 32. (See “Naming Con-
vention” on page 44.)

1. Import File Hame |C:\DF|AKE11\TB\PartnerslnGrimeTBXLS ﬂ

Figure 32: Selected file to import

Select the Trial Balance Additional Import Options. (See “Additional Import
Options” following this procedure.)

Click Next and wait for the import to be completed.
Click Finish.

The program returns to the Data Entry Menu for the open return. Note that all
selected data from the trial balance worksheet has been imported into the return. This
can be seen both in the data entry screens and on the generated return.

If the program does not calculate the trial-balance information as

NDTE expected, you can return to the trial balance worksheet, make adjust-

ments, and import the worksheet again.
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Additional The program can import the following additional information when importing the trial
Import  balance data (select the items to import or click Select All):

Options

Buildings & other depreciable assets ~ Accumulated depreciation

Land

Accumulated amortization

Special Conditions

Goodwill & other intangible assets

8825/Rent information

Some items cannot be entered into the trial balance worksheet and must be typed
directly into data entry. Other items should be entered into the worksheet for balance
purposes but are not imported to data entry; these must be entered separately and the
calculated results compared to the trial balance worksheet.

Details for Most items go directly to the location indicated in the program and on the return. For
Preparers example, the amounts shown in Figure 33 go to Schedule L, line 1, column d in the
program and are shown on page 4, Schedule L, line 1, column d of the 1120S return.

Debit Credit Import to: Reported on: h
GZU-,DSD L, line 1, cold Form 11208, Sch L, line 1, CDID
30 L, line 2a, colc Form 11205, Sch L, line 2a, colc
e Y ot M.UQ?W‘ it ol o Fapmd 1905 Cotntting 20 aol g

Figure 33: Indication of where an amount will go in Drake and on the return

Not all figures are imported directly, however, and some amounts are optional. Use the
“Other Information” column to indicate special conditions and additional information
regarding certain rows. Table 5 describes the most common notes in this column.

Table 5: “Other Information” Column Notes

Note

Description

not included in totals

The amount is required for importing purposes only but is
not included in the totals shown on the trial balance.

does not carry

Information cannot be imported and must be entered on the
appropriate screen in Drake. Screen is specified in column
to the left of “Other Information.”

optional

Amount is optional; not required for import, but could require
direct entry in the software.

enter as negative number

Some deficits must be entered as negative numbers.

import includes the calculated
change in inventory

Used for “total purchases”; when calculating cost of goods
sold (COGS) in the return, the program takes the change in
inventory into account for the Form 1125-A calculation.

[Form or Schedule] may be
required

Non-financial information must be completed in Drake, in
addition to the financial data entered in the worksheet.
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SCH2 Detail

All “does not carry” notes are accompanied by further instructions in the column to
the left of the “Other Information” column, as shown in Figure 34.

required for an item marked “does not carry” on the trial balance.

Typically, a balance sheet subsidiary schedule (SCH2 detail screen for Schedule L) is

Depreciation

- 0ol 21E dIARIRCAAIO e i, g, i st i R s e gy BB

Lot L HNE A7, RORCg-a |

Account Title Debit Credit Import to {screen, line): Form, Page, Sch and/or line Other Information
. “_Cﬁs-h.w\ o ap g q‘.‘....a;ﬁ\u; - '..V““M"“_Lﬂrﬁ_wo\ld e -\.—-«-\.....Eff,r[‘..lz-‘-s\ﬂ'mﬁf'-q,.ﬂ gl ettt g
et = R e P e ,,d_.-"’ s P LT S B . o e —
U.S8. government securities 50 L, line 4, cald Form 1120, SchL, line 4
Tax-exempt securities $0 L ling 5 cold Form 1120, Sch L line 5
Other current assets 50 ( Other Current Assets Detail SCH2 detail required in Drake does not carD
Loans to shareholders 50 L line 7, cold Form 1120, Sch L, line 7, col d
Mortgage and real estate loans 50 L line & cald Form 1120, 8ch L line 8 cald
Other investments 50 ( Other Investments Detail SCH2 detail required in Drake does not carD
Buildings and other depreciable assets 50 L, line 10a, cal ¢ Farm 1120, Sch L, line 104, col ¢ optional

F el Ut R S

Figure 34: SCH2 screen required for “do not carry” items

To complete an SCH2 detail screen in data entry:

1. Open the SCH2 screen in the return.
2. Select the line number from the SCH2 drop list.
3. Enter the applicable item descriptions and beginning- and end-of-year totals.

To enter details for additional lines of the Schedule L, press PAGE DOWN and repeat

steps 2 and 3. Data is saved automatically upon entry.

When the return is produced, the Schedule L of the return reflects both the amounts
imported from the trial balance worksheet and the totals of the amounts entered on the
SCH2 screen.

See “The SCH2 Screen” on page 25 for more details on using the SCH2 screen.

COGS
Real estate rental

Rental other than real estate

Any remaining depreciation

S corporation returns can have up to four components of total depreciation:

For trial balance purposes, enter depreciation amounts directly into the appropriate
fields on the trial balance worksheet. Note that, for 1120S trial balances, rental
expense detail worksheets are required for 8825 and RENT depreciation.

NOTE

Enter 8825 and RENT depreciation amounts in the detail work-
sheets for importing purposes, but be aware that the 8825 and
RENT screens in the program will have to be edited if 4562 detail

screens (see Figure 35) are used.
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When the trial balance is imported, the COGS depreciation expense amount flows
directly to the appropriate line of Form 1125-A of the return, and the rental deprecia-
tion expense amounts flow directly to the appropriate lines of the 8825 and RENT
screens, as applicable. Because the remaining depreciation can comprise any number
of assets, the amount entered on the trial balance does not flow to the return. To ensure
that each component of the total remaining depreciation is calculated into the return,

each asset must be entered on the applicable depreciation screens in data entry
(Figure 35).

Depreciable Assets

562
6
7
8

Depreciation - Detail ltem
4562 Part 1
4562 Parts 2 and 2
4562 Parts 4, 5a, and 6
4562 Parts 5b and 5c

10

Additional Depreciation Elections

Figure 35: Enter depreciable asset data on a 4562 detail screen, or enter the total depreciation

NOTE

on the override screens (screens 6, 7, 8, and 9). (Figure is from 1120S data entry menu.)

Entering the remainder of the depreciation on the trial balance work-
sheet helps ensure that the balance sheet balances and provides a way

line on Schedule M-1 of the calculated return. If the depreciation
amounts match but the line 1 amounts differ, an M-1 adjustment could

to check that the amount on line 1 of Schedule M-1 is correct. Compare
the calculated line 1 at the bottom of the trial balance to the equivalent

be required.
Rental The following information applies only to S corporations with multiple rental proper-
Expenses fties.
The S corporation trial balances include lines for rental income and expenses. Both
rental expense items require a trial balance detail worksheet.
Account Title Debit Credit Import to: Reported on:

Cash

Trade and accounts receivable

L, line 1, col d

L, line 2a, col c

Form 11205, Sch L, line 1, col
Form 11205, Sch L, line 2a, col ¢

Figure 36: Rental expense rows on an S corporation trial balance worksheet

Allowwance for bad debts 0 L, line 2h, col c Form 11205, Sch L, line 2a, col ¢
e B, AR PSSR W SR TSN TS——— O S W S i N N S ey FAPFCNPE
o= T ionmenm e, ot e rmem PP P W L YO P e = T, ,_.'U‘ér.m-yﬁr.'l-iﬁé?'wﬁ N
Tax-exempt interest F0 K, ling 163 Sch K, line 163, Sch -1, Line 5
Gross real estate rental income kili] G523, line 2 Form 8825, line 2
Total real estate rental expenses $E00 el (=i (R B reguires detail
Gross other rental income kili] REMT, line 1 Rert, Line 1
Tatal other rertal expenses $0 Ciinar Rzl B reguires detail j
Gross rovalties 600 K, line 6 Schedule K| line &
N L1 SO PPSU WS SR, J LT Ry S DL T

When imported, the rental expense data entered on the trial balance worksheet appears
on either the 8825 screen (if real estate rental) or the RENT screen (if rental other than
real estate).
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Because the trial balance worksheet has only one detail screen per rental type, the
importing function does not accommodate entities with multiple rental properties or
expenses; however, the following procedure allows the trial balance to remain in bal-
ance if there are multiple rental properties or expenses.

To accommodate entities with multiple rental properties or expenses:

1. Calculate the totals for both types of rental expenses.
2. Enter the income totals on the trial balance sheet and the expense totals on the
applicable detail sheets (Figure 36).
3. Ensure that the balance sheet is in balance.
4. Import the trial balance worksheet into the return. The applicable screens in data
entry now contain the figures entered on the trial balance worksheet.
5. Enter the amounts on additional screens that require details. (For more informa-
tion on data that cannot be imported, see “Special Conditions” on page 49.)
6. Compare the M-1, line 1 amount on the trial balance to the M-1, line 1 amount on
the calculated return to ensure that they match.
If the amounts do not match, review the imported amounts to ensure
NDTE that all data was imported. If the data appeared to import correctly, an
M-1 adjustment could be necessary.
7. Complete all 8825 or RENT screens in data entry, as applicable, for the individual
rental properties or items.
8. Delete the 8825 and RENT screens that were imported from the trial balance (the
screens reflecting the total rental expenses).
To delete a screen in data entry, open the screen and press CTRL+D. If
NDTE a multiple forms list appears, ensure that the screen to delete is

selected, then click Delete.

Form 3115, Application for Change in Accounting Method

Form 3115, Application for Change in Accounting Method, is an application to the
IRS to change either an entity’s overall accounting method or the accounting treat-
ment of any item. Drake customers can fill out Form 3115 and related schedules and
attachments for corporate returns. This section provides instructions for completing
this form and related schedules and attachments in Drake.

In some cases, Form 3115 must still be paper-filed. See “Parts | and Ill,”
starting on page 54, for details.

NDTES Applicants filing Form 3115 must refer to the Internal Revenue Bulletins

(available at www.irs.gov) to determine if the IRS has published an
accounting method revenue procedure, revenue ruling, notice, regula-
tion, or other guidance relating to the specific method to be changed.
See Pub. 538, Accounting Periods and Methods.
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Form 3115, Application for Change in Accounting Method

Accessing Screens for Changing Accounting Method

Several screens may be required to complete Form 3115. These screens are accessible
from the Change in Accounting Method box, located under the first Other Forms

tab of the Data Entry Menu (Figure 37).

F Farm Income and Expense
N Schedule M

Schedule K-1 Received
KAF Schedule K-1 from a Fiduciary
K1P Schedule K-1from a Partnership

RENT Rental (Non-Real Estate)

554  Application for Employer ID#

952 Debt Discharge

2220 Underpayment of Estimated Tax

25853 Election as Small Business Corporation
2848  Power of Attorney

Change in Accounting Method

3115 Change inAccounting Method

31ME Schedule E

ATT Explanations and Attachments
ATTZ2  PtllLn 12 & Ptill Ln 23bAttachment

Figure 37: Screens for Form 3115, Application for Change in Accounting Method

The screens accessible from the Change in Accounting Method section include:

Ganeral] ﬁ.ssets-salas-Ra-:aptura] Credits Miscellaneous

7004
8027
8082
8283
8697
8716
8752
8821
8822
8825
8832
8866
8873
8883
8903
8925
9022

e T

e R T SO

® Screen 3115 (Change in Accounting Method) — Used to access fields for Form

3115, including Schedules A through D

® Screen 311E (Schedule E) — Used to request a change in depreciation or amorti-

zation methods

e Screen ATT (Explanations and Attachments) — Used to create and view cer-

tain attachments to be generated by the software

* Screen ATT2 (Pt II Ln 12 & Pt III Ln 23b Attachment) — Used to complete
certain parts of Form 3115 that require specific attachments

Multi-form  All 3115 and related screens contain a Multi-form code text box (shown in Figure 38
Codes  on page 54) that allows you to link a screen or attachment to a particular Form 3115.

If submitting more than one Form 3115, assign a multi-form code to each new appli-
cation you create in Drake. The first should be 1, the second 2, and so on. When using
other screens, such as the 311E or ATT screens, you can use those numbers to indicate
which instance of Form 3115 the 311E or ATT screen should be associated with; see
“Screen 311E Multi-form Codes” on page 59 for more information.

N[H'E If only one Form 3115 is being submitted, you do not need to enter any-

thing in the Multi-form code box.

Tax Year 2011

53



Form 3115, Application for Change in Accounting Method Drake Software User’s Manual Supplement

Form 3115 Screens

When you open the 3115 screen from the Data Entry Menu, the program displays the
first of five 3115 screens. These five screens are:

e Parts I, III (Form 3115, Parts I and III)

e Parts II, IV (Form 3115, Parts II and IV)

* A,B,C (Form 3115, Schedules A, B, and C)

e D-LII(Form 3115, Schedule D, Parts I and II)
e D-III (Form 3115, Schedule D, Part III)

As shown in Figure 38, you can access these 3115 screens by clicking a link at the top
of any other 3115 screen.

(F_’arls 11 Parts IL IV AB.C D-Parts |1 D-Part il )

Form 3115 - Application for Change in Accounting Method i )

General Information

=L L e e —— ,.L_..._-.L..' O RS R
Figure 38: Tab links on 3115 screen

The next few sections of this document provide instructions for completing the vari-
ous screens for Form 3115 (including Schedules A through D).

Parts | and Ill  Use the Parts I, I1I screen to complete the following sections of Form 3115:

* General Information
* Part I, Information For Automatic Change Request
* Part III, Information For Advance Consent Request

NDTE Information should be entered in either the Part | section or the Part Il
section, but not both.

General Complete all applicable fields in the General Information section. Note that the
Information  fields for business activity and tax-year change are override fields (Figure 39). Com-
plete these fields only if you want to override the equivalent information entered on
screen 1 or screen K.

General Information
Principal business activity code NUMBEer. ... s

Tax year of change begins.
Tax year of change ends...........c.......

Mame of applicant (if different from filer)......

1D number of applicant (if different from filer)....

Mame of CONtACt PErSOM. ..o |
P r‘.-‘.-l-‘i ey r..,...-h“; PR R T Y T

Figure 39: Override fields in the General Information sections of the Parts I, I11 screen
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Part | Not all applicants are eligible to use the automatic change request procedures. After
answering la, 1b, and 2 in Part I - Information for Automatic Change Request,
click the blue Parts II, IV tab at the top of the screen.

In Part II — Information for All Requests, answer question 3 (see Figure 40). If the
answer is Yes, you are stating that:

* The entity would be required to take the entire amount of the section 481(a)
adjustment into account in computing taxable income for the year of change.
* Section 4.02(8) of Rev. Proc. 2002-9 applies to the applicant’s accounting method

change request, and the applicant is therefore not eligible for a change under auto-
matic change request procedures. (See IRS Form 3115 instructions for details.)

Parts LIl ABC D-Parts I D-Partll

Form 3115 - Application for Change in Accounting Method Multi-form code |
All applicants must complete Parts Il and IV.

Part Il - Information for All Requests

Mo | 4
@Did or will the applicant cease to engage in trade or business to which requested change relates 2. r ;

Beginning Date  Ending Date
da Are any federal returns under examination? ... | | ~
. o s, ... e ——— i e ABaan . T
et At AR e AT s s A gy e B st

Figure 40: Automatic Change Request information

Part lll  If this section of the Parts I, III screen is filled out, Form 3115 cannot be e-filed with
the return. It must instead be paper-filed before submitting the return. A user fee (a
check or money order payable to the IRS) must be included with the paper-filed form.

See Appendix A of Rev. Proc. 2006-1 for more information. For more on
applicants who must apply for advance consent, see the IRS Form

NDTES 3115 instructions.

Taxpayers filing under an automatic change request procedure do not
pay a user fee.

If the applicant qualifies for a reduced user fee, put a check mark in the box on line
23b and go to screen ATT2 to complete the attachment information in the Part I1I,
line 23b section (located in the bottom half of the screen). Include the necessary infor-
mation or certification required by Rev. Proc. 2010-1 (or its successor).

Specific statements must also be attached to the return if the applicant answers Yes for
line 18 (“Is change request allowed under automatic change?”’) or No for line 22 (“All
members of consolidated group use proposed method?)”. Press F1 in a specific field
for more information on attachment requirements. The method for attaching state-
ments in Drake is covered in “Attachments,” starting on page 60.

Parts Il and  Use the Parts II, IV screen to complete the following sections of Form 3115:
v

e Part II, Information For All Requests
* Part IV, Section 481(a) Adjustment
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Part Il, Line 12

Schedules A,
B,and C

Schedule A

Schedule B

In addition to the Multi-form code text box, this screen consists of the Part II and
Part IV sections. Applicants must complete both sections of this screen. For more on
each line (including instructions for required attachments), press F1 in a specific field.

Note that there is no field on the Parts II, IV screen for Part II, line 12. Fields for line
12, which should be completed if the applicant is changing only the accounting
method for a particular item or items, are located in the top half of ATT2 screen. Use
these fields to enter information on:

* The items being changed
* The applicant’s present and proposed methods for the items being changed
* The applicant’s present overall method of accounting (cash, accrual, or hybrid)

Note that the bottom half of the ATT2 screen is for completing Part III, line 23b. Only
the top half (for Part 11, line 12) needs to be completed for Part II, line 12.

Click the A, B, C link from screen 3115 screen to complete the following sections of
Form 3115:

*  Schedule A, Change in Overall Method of Accounting (screen covers Part 1,
Change in Overall Method)

* Schedule B, Change in Reporting Advance Payments

® Schedule C, Changes Within the LIFO Inventory Method (screen covers both Part
I, General LIFO Information, and Part II, Change in Pooling Inventories)

Schedule A, Part Il (Change to the Cash Method for Advance Consent

NDTE Request) requires attachments and is not addressed on the A, B, C

screen.

This section is required for all applicants filing to change their overall method of
accounting. It requires the entry of amounts as they were at the close of the tax year
preceding the year of the requested change.

Leave blank any lines that aren’t required for the entity’s application. In

NDTE addition, exclude amounts not attributable to the change in method of

accounting—for example, amounts that correct a math or posting error,
or that correct errors in calculating tax liability.

The IRS requires a worksheet for lines 1a, Ic, 1d, le, and 1f of Schedule A. When you
enter an amount on any of these lines in Drake, a CTRL+W worksheet is automatically
opened, allowing you to begin entering the descriptions and amounts of multiple items
for the worksheet. When you close a CTRL+W worksheet, the program returns to the
original screen and displays the total in the field. The field is shaded (default is red) to
indicate that a CTRL+W worksheet has been used.

NDTE If nothing is entered in a Schedule A field, the program automatically

displays the word “NONE?” in the field on the generated form.

This section has just two lines, both referring to the request for deferral for advance
payments:
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Schedule C

Schedule D,
Parts | and Il

Schedule D,
Part |

Schedule D,
Part Il

* Line 1 — Request change to the deferral method for advance payments (from sec-
tion 5.02 of Rev. Proc. 2004-34)

* Line 2 — Request change to the deferral method for advance payments (from sec-
tion 1.451-5(b)(1)(ii))

See IRS Form 3115 instructions for more information on making these requests.

This section has two parts:

e PartI (General LIFO Information) — This section is made up of attachment links
(see Figure 44 on page 60). If any of the conditions on lines 1-6 match the entity’s
situation, click the corresponding attachment link to access the ATT screen,
where you can complete the required statement. (Select the corresponding line
code from the Schedule drop list on the ATT screen.)

* Part II (Change in Pooling Inventories) — Enter the descriptions of the contents
and the base years of the present and proposed pools. If any of the conditions on
lines 2—4 match the entity’s situation, click the corresponding attachment link to
access the ATT screen, where you can complete the required statement.

Use the D - I, II screen to complete the following parts of Form 3115, Schedule D,
Change in the Treatment of Long-Term Contracts Under Section 460, Inventories, or
Other Section 263A Assets:

e Part I, Change in Reporting Income From Long-Term Contracts

* Part II, Change in Valuing Inventories Including Cost Allocation Changes

If an entity is currently using a LIFO inventory method or submethod

NDTE and is changing to another LIFO inventory method or submethod, Part

Il of Schedule D is not applicable. Use Schedule C, Changes Within the
LIFO Inventory Method, instead.

A long-term contract refers to any contract for the manufacture, building, installation,
or construction of property that is not completed in the tax year in which it is entered
into. Answer the questions in Part I that apply to the entity’s situation.

This section concerns changes in the identification and valuation methods of invento-
ries. Note that some lines require attachments. To access the ATT screen and complete
a required statement, click the desired attachment link.

The items on this part of the screen match the items on the actual Form 3115, Sched-
ule D. For information on completing individual lines, see the Form 3115 instructions.

If the entity is unable to furnish a copy of Form(s) 970 (line 5a), the
attachment must include the following statement:

N[H'E “| certify that to the best of my knowledge and belief (name of applicant)

properly elected the LIFO inventory method by filing Form 970 with its
return for the tax year(s) ended (insert date(s)) and otherwise complied
with the provisions of section 472(d) and Regulations section 1.472-3.”
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Schedule D,

Part il

Section A

Sections
B and C

Use the D - III screen to complete Part 111 (Method of Cost Allocation) of Form 3115,
Schedule D. Part 111 is required for any entity submitting either Part I or Part II. Screen
D - III consists of the following sections:

* Section A, Allocation and Capitalization Methods
* Section B, Direct and Indirect Costs Required to be Allocated
* Section C, Other Costs Not Required to be Allocated

Click the D3-1 Attachment link (see Figure 42) to attach a description of the present
and proposed methods used to capitalize direct and indirect costs.

These sections consist of a series of drop lists under a Present column and a Proposed
column. “Present” refers to the current accounting method, while “proposed” refers to

the requested change in accounting methods. You should address only the items neces-
sary; do not make a selection for any item for which an answer is not required for the

entity’s situation.

For each item in sections B and C, you can:

* Select X — If you select X, the corresponding box on Form 3115 will be marked
with an X. (See Figure 41.)

* Select B— Ifyou select B, the corresponding box on Form 3115 will be left blank
and an attachment will be required explaining why the line was left blank.

¢ Select nothing — If you select neither of the above options, “N/A” will appear in
the corresponding box on Form 3115. No attachment is necessary for a box
marked “N/A.”

AT ik, 0 A BT THE P It = B0ty o F SEE7 B AT £ ABULTSE BT S 18 N A TR e f R B i, e om0 o
required. Attach an explanation for boxes that are not chedied.)
Fresent method Fropozed method
4 Direct MAEHAl « = o o = & o & m t v m e e e e e e e m e X Hfn
2 Direct|abors = = = = &+ = 5 5 4 = o4 s om s rwomowow omoa s xomoxow s oms s womoa o oma s H/n
3 INiEet 13BN« « =+« x « x v ke e e e e e e e e e e e e e e e e e n/n HiR
4 Officers compensation (not including selling activitiagk « = « 0 o 0 v v 0 v o w v v e e o w aw e Hin H/R
5 Pension and otherrelated costs= » = = = + & = ¢ & = & & & = s 0 = x w8 omom s aawwaom N[n H/n
i R A A i g, b g Bl gL

Figure 41: X was selected for column 1, line 1; B was selected for column 1, line 2;
nothing has yet been selected for any other line. (See also Figure 42.)

To attach a statement for section B or C, click the D3-2 Attachment link at the top of
Section B. (See Figure 42.) A single statement may contain all necessary explanations
for sections B and C.
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Parts 1. Il Pars II, IV ABC D-Pans |, Il D - Partlll

Form 3115 - Schedule D, Part lll - Method of Cost Allocation Multiform code
Section A-Allocation and Capitalization Methods
D31 attachment Allocation and capitalization methods detail.

g irectand Indirect Costs Required To Be Allocated
D3-2 attachment JExplanation for boxes that are not checked.  X=Check, B=Blank, No Selection=NiA
1 Direct material...

Present Proposed

2 Directlabor........
J IMTITECE AEIIN ..ottt ettt :I" :"
4 Officers’ compensation (notincluding selling activities ). ..o hul hl

B VPP, N ra b i e o e ol it “'.‘\F‘IW“?“—

Figure 42: If any box is marked “B,” click the D3-2 Attachment link to open
the ATT screen and complete the fields for an attached statement.

Schedule E

Use screen 311E, accessible from the Change in Accounting Method section of the
Other Forms tab, to complete Schedule E, Change in Depreciation or Amortization.

If changing this method under the automatic change request proce-
NDTE dures, see the “List of Automatic Accounting Method Changes” in the
IRS Form 3115 instructions.

Screen 311E  Unlike the other 3115 screens, screen 311E contains two multi-form code text boxes:
Multi-form
Codes * Multi-form code for 3115 — This box is applicable if the return contains more

than one Form 3115. Enter the code for the instance of the 3115 screen with which
this 311E screen should be associated.

*  Multi-form code for Sch E — This box is applicable if the return contains more
than one Schedule E. (A separate 311E screen should be used for each property.)
Assign each property a separate code in its Multi-form code for Sch E. This code
enables you to associate any attachments with the correct Schedule E property.
(See “Attachments,” starting on page 60.)

If the return contains more than one Form 3115 and multiple instances of Schedule E,
both multi-code fields should contain numbers. Figure 43 shows that the third instance
of a Schedule E is to be associated with the second Form 3115 in the return.

Form 3115 - Application for Change in Accounting Method

Schedule E - Change in Depreciation or Amortization

Multi-form code for 3115 2 Multi-form code for Sch E 3)

Schedule E - Line 43

tMﬂ-ld' -

TYRE OF PrOPEIY. oo |BUilﬂiﬂg
Year property was placedin semice. ... ,m
L <L aa o RTORRILGSR 308 QL DUSINAFS-OT IDCOME. oy gaststvn. B, 0580 mimnd s, i mm et nan gt 0

Figure 43: Example of third instance of a Schedule E to be associated
with the second instance of a Form 3115.
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Completing The 311E screen consists of four sections:

Schedule E
* Schedule E - Line 4a — Enter information on the type of property, the year it was

placed in service, and the property’s use.

* Schedule E - Change in Depreciation or Amortization — This section covers
all Schedule E items other than lines 4a and 7. Note that lines 5 and 6 are links to
required attachments.

* Schedule E - Line 7 - Present Method and Schedule E - Line 7 - Proposed
Method — For the line 7 sections, enter information on the Present Method and
Proposed Method in the supplied text boxes and choose the applicable conven-
tion from the Applicable Convention drop list. Options are as follows:

e HY — Half-Year ¢ MM — Mid-month

*  MQ — Mid-quarter * S/L — Straight line

Attachments

Attached statements are required for many Form 3115 items. Depending on the nature
of the attachment, you will attach statements to the form in one of two primary ways:

*  From Data Entry — The ATT screen is the most common screen for attaching
statements to Form 3115. The ATT2 screen is used for Part II, line 12, and Part
111, line 23b. (See the “Parts I and III”” and “Parts II and IV” sections of this docu-
ment for more information on completing the ATT2 screen for these items.)

*  From View Mode — Used for PDF attachments.

ATT Screen There are two ways to access the ATT screen in Drake:

Attachments
*  From the Data Entry Menu — In the Change in Accounting Method section of

the Other Forms tab, click ATT. (See Figure 37 on page 53.)
*  From the line that requires an attachment — As shown in Figure 44, some
lines have attachment links. Click an attachment link to open the ATT screen.

Schedule C - Changes Within the LIFO Inventary Method

Part |

C1-athry ©1-h attachments NChanging within the LIFO Inventary Method .. r
C1-2 aftachment If any presént method or submethod is notthe same as indicated on Formis) 970.
C1-3 attachment Ifthe propdsed change is not requested for all the LIFO inventary.

C1-4 attachment Ifthe propdsed change is not regquested for all the LIFO poals.

C1-5 attachment LIFO invenfary valued on method ather than cost.

C1-6 attachment If changing to the IPIC method.

@ N e W N o=

Partll

1 Change in Pooling Inventaries?
i Bt T o At BTN ettt o e B e, g

Figure 44: Attachment links from Schedule C (screen A, B, C)

Not all lines that require statements include a link to the ATT screen.

NDTE Always check the field-level help (click F1 in a field) to determine if a
statement is required. The program produces an EF Message if any
required statements are missing.
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Additional
ATT Fields

PDF
Attachments

Complete the following ATT fields, as applicable, for all ATT screen attachments:

*  Multi-form codes — Use these boxes to associate the attachment with an
instance of Form 3115 (if the return contains more than one), a particular Sched-
ule E property (if the return contains more than one Schedule E), or both. (See
“Multi-form Codes” on page 53 for more information on multi-form codes.)

¢ Schedule — Select the line of the form or schedule with which the attachment is
to be associated. If an item begins with a number, it refers to the part of Form 3115
(for example, 2-4e refers to Part 11, line 4e). If it begins with a letter, it refers to a
particular Form 3115 schedule (for example, C2-b refers to Schedule C, line 2b;
C2-5 refers to Schedule C, Part 2, line 5).

¢ Explanation — Enter the statement explanation. If the explanation requires more
than 900 characters, press PAGE DOWN for a second screen.

If the explanation requires more than seven screens, only the first 6,500

NDTE characters of the explanation are transmitted with an e-filed Form 3115.

There is no character limit for paper-filed returns.

The ATT screen has a separate section, to be used only for Part I, line 10. The IRS
requires that the attached statement, in addition to providing an explanation, include
the taxpayer’s name and ID number. Enter the name and ID number, and indicate if
the ID number is an EIN, in the applicable fields at the bottom of the ATT screen
(Figure 45).

For STh 2-10 ( Part Il, Line 10 Statement) OkLY

Figure 45: Special section for entering taxpayer name and ID number
for Part II, line 10; located at bottom of the ATT screen.

Some Form 3115 items require the attachment of documents that cannot be created in
Drake Software; for example, line 4d of Part Il requires written consent from a direc-
tor. You can, however, attach such a document to the form as a PDF.

See the PDF screen for directions on generating and attaching PDFs. Click the Screen
Help button for directions on converting other types of documents into PDF.

Do not enter data on the PDF screen itself. If using the directions pro-
vided on that screen, skip Step 2, which instructs you to fill out the col-

NDTES umns at the bottom of the PDF screen.

A PDF document may be attached using any filename. When you
attach the document, the program automatically assigns it the filename
required by the IRS.

When the return is generated, an “EF Attachments” worksheet is produced. (See
Figure 46.) This worksheet shows, in table format, the Reference (section of Form
3115), the Description, and the IRS-required Filename of each required PDF docu-
ment. This worksheet is displayed as EF_ PDF~ in View mode.
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Notices of
Missing
Attachments

EF_PDF-~

(KEEP FOR YOUR RECORDS)
EF Attachments

Hame ot coiporation
PARTHERS IH GEIME CLEANING

Reference

Description

Filename:

3115 ,III,Line 20 Proposed Change Documents
3115,4,I,Line 3 Proposed Change Documents

N s T WYV

ProposedChangeDocuments. pdf
SchaPartIProfitLossStatements. pdf

e Y Lt SR e e A e MBS

P i A A B s b e P s o

Figure 46: Example of an EF Attachments worksheet

In addition to Form 3115 and related schedules and statements, the program produces
EF message pages (as applicable) when the return is calculated. All forms, schedules,
EF message pages, and worksheets are accessible from View mode.

EF messages for Form 3115 provide information about required attachments (includ-
ing PDF attachments) that are missing from the return. Some messages list all state-
ments required for a particular section but do not indicate which statements,
specifically, are missing. To best understand which attachments are still required,
compare the ATT screen and the EF PDF~ worksheet to the list on the EF message

page.

NOTE

All EF messages must be eliminated before the return is eligible for
e-file. EF messages for Form 3115 attachments are eliminated
when all required statements have been attached to the return.
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Appendix A: Trial Balance Import

The trial balance import allows data to be imported into a corporate tax return from a
trial balance worksheet.

Drake’s specially designed trial balance template and importing function has the fol-
lowing benefits:

¢ Eliminates the need to duplicate entries
* Eliminates data entry errors by automatically importing data to the correct fields

* Allows preparers to merge basic accounting functions with tax preparation

See next page for a flow chart describing the use of the trial balance import.
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Trial Balance Import: General Process

Prepare to use Trial
Balance Import

- Enable Excel macros

- Disable autobalance

- Force Schedule L

- Delete unnecessary detail worksheets

.990-PF return?

Populate Trial Balance

Template
(Import > Trial Balance Import)

- direct entry data (cells with $o)
- applicable detail worksheets
- totals for:

- depreciation

- Schedule L

- rentals (1120S & 1065 only)

Populate Data Entry

Enter any trial balance data that cannot be
imported via Trial Balance Import

- Screen SCH2 for Schedule L items
- Screen 4562 for individual assets
(depreciation)

YES

990, 990-EZ, or

4 00 vV —

Make
corrections in

TB worksheet

Compare M-1, line 1: Does trial balance
match Schedule M-z, line 1?7

. _YES»

NO

Did data
import
correctly?

Isan M-1
adjustment
necessary?

YES

Make M-1
adjustment

Adjust
amounts

elsewhere in
data entry

1120S & 1065:
—NO} Were rental totals entered
in trial balance?

YES

Go to data entry an |
enter individual |
rentals on 8825 or |
RENT screens as
applicable

Delete imported
8825 and RENT
screens

Process

complete!
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Appendix B: Adjustment Worksheet

The Adjustment Worksheet is updated each year to help you understand what happens
in the return when certain data is changed through the use of adjustment fields. The
following pages contain the 2011 Adjustments worksheet.

These worksheets are also available through the FAQ screen. To access them, open
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the
links at the top of the window.

Tax Year 2011
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Adjustments Worksheet

Adjustment Location

Screen/Line ’Field Name Location of Information Beini Adjusted

INC - Income and Common Schedule K ltems

4

Schedule K: Most Common Items : Interest income

Adjusts the amount that flows from Form 6252.

16¢

Schedule K: Most Common Items : Nondeductible
expenses - other

Adjusts the calculated nondeductible expenses and limitations.

DED - Deductions

1l4a Depreciation Adjusts the amount that flows from Form 4562 calculations.
14b Depreciation claimed elsewhere on return (Other than [Adjust the amounts carried to or entered elsewhere in the
Schedule A) return, such as the Schedule A, line 5.
15 Depletion (do not deduct oil and gas depletion) Adjusts the amount entered on the K1F screen, line 9, code B.
. Adjusts the amount that flows from Schedule F, line 17 to this
18 Employee benefit programs line
Adjusts the amount that flows from Schedule F, lines 23 (a) and
13 Interest expense
23(b).
17 Pension, profit-sharing, and other plans Adjusts the amount that flows from Schedule F, line 25.
9 Repairs and maintenance Adjusts the amount that flows from Schedule F, line 27.
Adjusts the amount that flows from Schedule F, lines 26 (a) and
11 Rents
26(b).
8 Salaries and wages paid to non-shareholder Adjusts the amount that flows from Schedule F, line 24.
employees
11 Other miscellaneous taxes Adjusts the amount that flows from Schedule F, line 31

Tax & Payments Worksheet for Line 22a

Adjusts the combined amounts of gross receipts entered on

1 Gross receipts for the tax year screen 3 and Schedule F.
- . Adjusts amounts entered on Schedule K for royalties, rents,
2 Passive investment income L ) i
dividends, interest, annuities.
5 Deductions directly connected with passive income on [Adjust amounts calculated from entries on Schedule K for line
line 2 12b and for line 12d, codes I, K and L.
Form 1125-A - Cost of Goods Sold

1 Inventory at beginning of year Adjusts amount coming from Schedule F, line 46.

2 Purchases Adjusts amount coming from Schedule F line 47.

7 Inventory at end of year Adjusts amount coming from Schedule F, line 49.

Schedule K - Shareholders' Pro Rata Share Items (Screen 1 of 2)

Adjusts interest income flowing from the income and deductions

4 Interest income screen (screen 3), Form 6252, screen K1P, line 5 and screen
K1F, line 1.
5a Total ordinary dividends Adjusts qrdlnary dividends flowing from screen 3, the K1P
screen, line 6a, and from the K1F screen, line 2a.
5p Qualified dividends Adjusts quallfled dividends flowing from scr.een 3, the K1P
screen, line 6b. and from the K1F screen, line 2b.
6 Royalty Income Adjusts amounts entered on K1P screen, line 7.
8b Collectibles (28%) gain (loss) Adjusts amou.nts flowing from the K1P screen, line 9b, and the
K1F screen, line 4b.
10A Other portfolio Adjusts amounts fIOW|_ng from the K1P screen, line 11, code A
and the K1F screen, line 5.
10B Involuntary conversions Adjusts amounts flowing from the K1P screen, line 11, code B.
10D Mining exploration costs recapture Adjusts amounts flowing from the K1P screen, line 11, code D.
. Adjusts amounts being carried from screen K1P, line 11, code
10E Other income (loss ’ ’
( ) F; and K1F screen, line 11, code D.
12a A Cash contributions (50%) Overrlde_s amounts flowing from screen 3 and from the K1P
screen, line 13, code A.
12a B Cash contributions (30%) Adjusts amounts flowing from the K1P screen, line 13, code B.




Adjustments Worksheet

Adjustment Location

Screen/Line |Fie|d Name Location of Information Beini Adjusted

Adjusts amounts flowing from the 8283 screen and from the

12aD Noncash contributions (30%) K1P screen. line 13. code D.
12a E Capital gain property to a 50% organization (30%) Adjusts amounts flowing from the K1P screen, line 13, code E.
12a F Capital gain property (20%) Adjusts amounts flowing from the K1P screen, line 13, code F.
12a G Cash contributions (100%) Adjusts amounts flowing from the K1P screen, line 13, code G.
12bH Investment interest expense Adjusts amounts flowing from the K1P screen, line 13, code H.
12¢J Section 59(e)(2) expenditures Adjusts amounts flowing from the K1P screen, line 13, code J.
12d | Deductions - royalty income Adjusts amounts flowing from the K1P screen, line 13, code |I.
12d K Deductions - portfolio (2% floor) Adjusts amounts flowing from the K1P screen, line 13, code K.
l2dL Deductions - portfolio (other) Adjusts amounts flowing from the K1P screen, line 13, code L.
12d M Preproductive period expenses Adjusts amounts flowing from the K1P screen, line 13, code P.
12d N Commercial revitalization deduction from real estate  |Adjust amounts flowing from the K1P screen, line 13, code Q.
12d O Reforestation expense deduction Adjust amounts flowing from the K1P screen, line 13, code S.
12d S Other deductions Adjusts amounts flowing from screen K1P, line 13, code W.
13d Other rental real estate credits Adjusts amounts flowing from the K1P screen, line 15, code F.
13e Other rental credits Adjusts amounts flowing from the K1P screen, line 15, code G.
13gH Undistributed capital gains credit Adjusts amounts flowing from the K1P screen, line 15, code H.
139 P Other credits Adjust amounts flowing from various credit forms without

specific K1 codes and the K1P screen, line 15, code P.

Schedule K - Shareholders' Pro Rata Share Items (Screen 2 of 2)

14b Gross income from all sources Adjust amounts flowing from the K1P screen, line 16, code B.
1l4c Gross income sourced at shareholder level Adjust amounts flowing from the K1P screen, line 16, code C.
14d Passive category Adjusts amounts flowing from the K1P screen, line 16, code D.
14e General category Adjusts amounts flowing from the K1P screen, line 16, code E.
14f Other Adjusts amounts flowing from the K1P screen, line 16, code F.
149 Interest expense Adjusts amounts flowing from the K1P screen, line 16, code G.
14h Other Adjusts amounts flowing from the K1P screen, line 16, code H.
14i Passive category Adjusts amounts flowing from the K1P screen, line 16, code |I.
14j General category Adjusts amounts flowing from the K1P screen, line 16, code J.
14k Other Adjusts amounts flowing from the K1P screen, line 16, code K.
141 Foreign taxes paid Adjusts amounts flowing from the K1P screen, line 16, code L
and the K1F screen, code B.
141 Foreign taxes accrued Adjusts amounts flowing from the K1P screen, line 16, code M.
14m Reduction in taxes available for credit Adjusts amounts flowing from the K1P screen, line 16, code N.




Adjustments Worksheet

Adjustment Location

Screen/Line |Fie|d Name Location of Information Beini Adjusted

Adjusts amounts flowing from Form 8873, line 15, the K1P

14n0 Foreign trading gross receipts screen, line 16, code O, and the K1F screen, line 14, code G.
14n P Extraterritorial income exclusion Adjusts a_lmounts flowing from form 8873 line 52, and the K1P
screen, line 16, code P.
14n Q Other foreign transactions Adjusts amounts flowing from the K1P screen, line 16, code Q.
Adjusts the calculated difference between the current
15a Post-1986 depreciation adjustment deprem_atlpn ar_1d.AMT depremaﬂoq totals on the Federal.
Depreciation Listing, amounts flowing from K1P screen, line 17,
code A, or the K1F screen, line 12, code A or G.
15b Adjusted gain or loss Adjusts amounts Tlowmg from K1P screen, line 17, code B or
the K1F screen, line 12, code C-F.
. . Adjusts amounts flowing from K1P screen, line 17, code C, or
15¢ Depletion (other than oil and gas ! ! '
P ( gas) the K1F screen, line 12, code H.
15d Gross income from oil, gas, and geothermal Adjusts amounts flowing from K1P screen, line 17, code D.
15e Deductions from oil, gas, and geothermal Adjusts amounts flowing from K1P screen, line 17, code E.
15¢f Other AMT items (attach schedule) Adjusts amou.nts flowing from K1P screen, line 17, code F, and
K1F screen, line 12, codes | and J.
16a Tax-exempt interest income Adjusts amounts flowing from K1P screen, line 18, code A, and
from the K1F screen, line 14, code A.
16b Other tax-exempt income Adjusts amounts flowmg from the bottom of screen 3, line 16b,
and from K1P screen, line 18, code B.
16¢ Nondeductible expenses Adjusts amounts flowing from the bottom of screen 3, line 16c,
and from K1P screen, line 18, code C.
16¢ Officer life insurance premiums Adjusts amounts flowing from the bottom of screen 3, line 16c.
17a Investment income Adjusts amounts flowing from the K1P screen, line 20, code A.
17b Investment expenses Adjusts amounts flowing from the K1P screen, line 20, code B.
17d H Recapture of other credits Adjusts amounts flowing from the K1P screen, line 20, code I.
Adjusts the amounts flowing from the WK_179, net gain or loss
17d K Dispositions of property with section 179 deductions  |on sale of an asset subject to section 179, and the K1P screen,

line 20, code L.
Adjusts amounts flowing from Form 4797, line 35 and K1P
screen, line 20, code M.

17d L Recapture of section 179 deduction

17d M Section 453(1)(3) information Adjusts amounts flowing from the K1P screen, line 20, code O.
17d N Section 453A(c) information Adjusts amounts flowing from the K1P screen, line 20, code P.
17d O Section 1260 (b) information Adjusts amounts flowing from the K1P screen, line 20, code Q.
17d P Interest allocable to production expenditures Adjusts amounts flowing from the K1P screen, line 20, code R.
17d Q CCF nonqualified withdrawals Adjusts amounts flowing from the K1P screen, line 20, code S.
17d R Information needed to figure depletion - oil and gas Adjusts amounts flowing from the K1P screen, line 20, code T.
17d S Amortization of reforestation cost Adjusts amounts flowing from the K1P screen, line 20, code U.

Adjusts amounts flowing from the K1P screen, line 20, code V

17d U Other information
or W.

Shareholder's Adjusted Basis Worksheet

Adjusts the calculated amount from the WK_SBAS, page 2,
current-year losses and deductions, line 7a.
Schedule M-1 - Reconciliation of Income (Loss) per Books with Income per Return
Income recorded on Sch K, lines 1,2,3c,4,5a,6,7,8a,9
2
and 10 not on books

7a Nondeductible expenses and credit adjustments

Adjust the amounts coming from Forms 6478 and 8864.




Adjustments

Worksheet

Adjustment Location

Expenses recorded on books this year not included on

Screen/Line |Fie|d Name Location of Information Beini Adjusted

Adjust amounts credit adjustments made from Forms 5884,
6765, 8820, 8844, 8845, 8846, 8881, nondeductible expenses

K, lines 1 through 10: Other

3 Schedule K, lines 1 through 12 and 141 (or 14m): Other entered on the bottom of s.creen 3 for line 16¢ aqd amounts
entered on K3 screen for line 16c for nondeductible expenses
and officer life insurance premiums.

5 Income recorded on books not included on Schedule |Adjust the amounts entered on screen 3, line 16b and from

Schedule K screen, line 16b for officer life insurance proceeds.

Schedule M-2 - Analysis of Accumulated Adjustments Account

3(a) Other additions Adjusts the amounts that flow from Schedule K, line 10
Adjusts amounts flowing from screen 3, line 16b, officer life
3 (b) Other additions insurance proceeds and amounts entered on Schedule K, line
16b for tax exempt interest.
Adjusts the sum of the amounts coming from Schedule K, line
5(a) Other reductions 11, Schedule K, line 12d (Other Deductions) S; and Schedule K,
line 16¢c (Nondeductible expenses).
5 (b) Other reductions Adjgsts amount; from screen 3, line 16.c or Schedule K (screen
3), line 16c (Officer life insurance premiums).
Adjusts amounts from screen 3, line 16d, and from Schedule K,
7 (@) Non-dividend distributions line 16d, subject to limitations due to negative amounts on line 6
or both lines 6 and 1.
4562 Part 1
10 Carryover of disallowed deduction from prior year Adjusts amounts from the 4562 screen.
Form 5884 - Work Opportunity Credit
3 Work opportunity credit from pass-through entities Adjusts gmounts from K1P screen, line 15, code J and K1F
screen, line 13, code F.
Form 6478 - Alcohol and Cellulosic Biofuel Fuels Credit
8 Pass-through credit from other entities Adjusts amounts from K1P screen, line 15, code |, and K1F

screen, line 13, code H.

Form 6765 - Credit for Increasing Research Activities

37

Pass-through research credits

Adjusts amounts from K1P screen, line 15, code M and K1F
screen, line 13, code |.

Form 8820 - Orphan Drug Credit

3 [Orphan drug credit(s) from pass-through entities [Adjusts amounts from K1F screen, line 13, code M.
Form 8826 - Disabled Access Credit
7 [Disabled access credits from pass-through entities [Adjusts amounts from K1P screen, line 15, code K.

Form 8844 - Empowerment Zone Employment Credit

3

Form 8844 credits from pass-through entities

Adjusts amounts from K1P screen, line 15, code L and K1F
screen, line 13, code K.

Form 8846 - Credit for Employer SS and Medicare Taxes Paid on Certain Employee Tips

through entities

5 [Form 8846 credits from pass-through entities |Adjusts amounts from K1P screen, line 15, code N.
Form 8864 - Biodiesel Fuels Credit
Biodiesel and renewable diesel fuels credit from pass- . .
9 Adjusts amounts from K1F screen, line 13, code O.

8882 - Credit for Employer-Provided Childcare Facilities and Servic

es

5

[Amount

|Adjusts amounts from K1F screen, line 13, code N.

Form 8907 Nonconventional Source Fuel Credit

12

Nonconventional source fuel from partnerships, S
corporations, estates and trusts

Adjusts amounts from K1F screen, line 13, code P.

Form 8909 Energy Efficient Appliance Credit

Energy-efficient appliance credit from partnerships, S

An entry here adjusts amounts being carried from

24 corporations, estates, trusts, and cooperatives the K1F screen, line 13, code S.
Schedule F - Farm Income (Informational Purposes Only)
10 Car and truck expenses Adjusts qmount being carried from screen 9 calculations for
automobile expenses.
14 Depreciation Amount is carried from Form 4562 calculations.

RENT - Rental

Other than Real Estate




Adjustments Worksheet

Adjustment Location

Screen/Line |Fie|d Name Location of Information Beini Adjusted

Adjusts depreciation amounts calculated by the program from
entries on the 4562 screens.

15 Depreciation

Form 8825 - Rental Real Estate

14 |Depreciation |Adjusts the depreciation calculated from the 4562 screens
Form 8903 - Domestic Production Activities Deduction
7 Qualified production activities income from pass- Adjusts amounts from K1P screen, line 13, code U, and K1F
through entities screen, line 14, code C.
17 Form W-2 wages from pass-through entities Adjusts amounts from K1P screen, line 13, code V, and K1F

screen, line 14, code D.
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Appendix C: Override Worksheet

The Override Worksheet is updated each year to help you understand what happens in
the return when certain data is changed through the use of override fields. The follow-
ing pages contain the 2011 Override worksheet.

These worksheets are also available through the FAQ screen. To access them, open
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the
links at the top of the window.

Tax Year 2011
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Overrides Worksheet

QOverride Location

Screen/Line

Field Name

1 S Corporation General Information screen

Location of Information Being Overridden

Item |

Number of shareholders at tax-year end

Overrides number of K1 screens in return.

Preparer fee

Overrides the system's fee calculation

Firm # Overrides the program default setting (1).
Preparer # Overrides the program default setting (1).
Data entry op # Qverrides the login hame.
Overrides the selection made from the ERO SSN Indicator drop
ERO number

list at Setup > Options, EF tab.

DED - Deductions

Insurance

QOverrides the other insurance amounts below.

State income taxes

Overrides state income taxes calculated from information
entered on ES screen using code IN.

2

State franchise taxes

Overrides state franchise taxes calculated from information
entered on ES screen using code FR..

Tax & Payments (bottom of page 1 of Form 1120S)

23a Current-year estimated tax payments Overrides payments made as entered on ES screen.
23b Tax deposited with Form 7004 Overnqles amount entered on 7004 screen: Amount paid with
extension.
27 Amount to be credited to next year's estimated tax Overrides overpayment amount as entered on ES screen.
Form 1125-A - Cost of Goods Sold
- Overrides calculated amount for entries on 4562 detail screen
5 Depreciation . ) )
directed to the COGS in the Form selection box.
Schedule K-1 - Shareholder's Share of Income, Credits, Deductions, etc.

Amounts entered on the K1 screen override the amounts
automatically calculated by the K screen.

Shareholder's Adjusted Basis Worksheet

Overrides the calculations from Schedule K or the overrides in

5 Less: Non-taxable distributions Schedule K-1.
15 Loans repaid by corporation during the vear Overrides the calculations from Schedule K or the overrides in
P Y corp 9 Y Schedule K-1.
9 Allowed Decreases for Losses and Deductions Items a-|Overrides the calculations for column F of shareholder's basis
p worksheet, page 2.
7a Nondeductible expenses and credit adjustments Overrides the calculations for column F of shareholder's basis
worksheet, page 2.
. . Overrides the calculations for column F of shareholder's basis
7b Oil and gas depletion
worksheet, page 2.
Schedule L - Balance Sheet - Assets
. Overrides entries from screen A - Cost of Goods Sold, line 1
3(b) Inventories -
Inventory at beginning of year.
. Overrides entries from screen A - Cost of Goods Sold, line 7
3(d) Inventories
Inventory at end of year.
. Overrides calculations from on the 4562 detail screen or the
10a (a) Depreciable assets L
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
10a (c) Depreciable assets Overrides calculations from on the 4562 detail screen or the
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
. Overrides calculations from on the 4562 detail screen or the
10b (a) Less accumulated depletion -
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
10b (c) Less accumulated depletion Overrides calculations from on the 4562 detail screen or the
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
12 (b) Land Overrides calculations from on the 4562 detail screen or the
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
12 (d) Land Overrides calculations from on the 4562 detail screen or the
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
13a (a) Intanaible assets Overrides calculations from on the 4562 detail screen or the
9 Subsidiary Schedule for the Balance Sheet (SCH2 screen).
13a (c) Intanaible assets Overrides calculations from on the 4562 detail screen or the
9 Subsidiary Schedule for the Balance Sheet (SCH2 screen).
13b (a) Less accumulated amortization Overrides calculations from on the 4562 detail screen or the
Subsidiary Schedule for the Balance Sheet (SCH2 screen).
o Overrides calculations from on the 4562 detail screen or the
13b (c) Less accumulated amortization

Subsidiary Schedule for the Balance Sheet (SCH2 screen).




Overrides Worksheet

QOverride Location

Screen/Line

Field Name

Schedule M-1 - Reconciliation of Income (Loss) per Books with Income per Return

Location of Information Being Overridden

Expenses recorded on books this year not included on

Overrides the amounts carried from the Schedule K, lines 1-12

3 schedule K, line 1-12 and 14l (or m) and 14l (or m).
Deductions included on Schedule K line 1 through 12 . . .
6 and 141 (or 14m), not charged against book income this Overrides the amounts carried from the Schedule K, lines 1-12

year

and 14l (or m).

Schedule M-2 - Analysis of Accumulated Adjustments Account...

7 Non-dividend distributions

Overrides the amount that flows from Schedule K (screen 3), line
17c.

Schedule M-3 - Net Income/Loss Reconciliation

2 Income statement period,
Beginning

Overrides default calendar year dates or fiscal year dates
entered on screen 1

2 Income statement period,

Ending

Overrides default calendar year dates or fiscal year dates
entered on screen 1

Electronic Funds Withdrawal Information

Federal payment amount

Overrides line 25 of Form 1120S, or Form 7004, line 8 (software
calculated)

Federal: Requested Payment date

Overrides federal return due date.

Federal: daytime phone number

Overrides phone number entered on screen 1 (General Info)

Print Options

Print general filing instructions

An entry here overrides the selection on Setup > Options,
Optional Documents tab for printing the federal return.

Print state filing instructions

An entry here overrides the selection at on Setup > Options,
Optional Documents tab for printing the state return.

Print S Corporation's envelope coversheet

An entry here overrides the option that was entered in on Setup
> Options, Optional Documents tab for the S corporation
envelope coversheet.

Print IRS envelope coversheet

An entry here overrides the option that was entered on Setup >
Options, Optional Documents tab for the IRS envelope
coversheet.

Print state envelope coversheet

An entry here overrides the option that was entered on Setup >
Options, Optional Documents tab for the state envelope
coversheet.

Print city envelope coversheet

An entry here overrides the option that was entered on Setup >
Options, Optional Documents tab for the city envelope
coversheet.

Date to print on returns

Overrides the default date on the "Paid Preparer" line at the
bottom of the 1120, page 1.

Due date to print on letter and filing instructions

Overrides the default due date that is printed on letters and filing
instructions

Total assets on Form 1120S, page 1, line F

Overrides the calculated amount on Form 1120, page 1, line F.

IRS Center

Overrides the IRS Center address generated from screen 1.

Form 2439 - Notice to Shareholder of Undistributed Long-Term Cap

ital Gains

Federal ID number

Qverrides entry on screen 1.

Regulated investment company's name, in-care-of
name (if needed) address, city, state, and ZIP code

Overrides entry on screen 1.

Fiscal Year beginning/ending

Overrides default calendar year dates or fiscal year dates
entered on screen 1

Shareholder's name, in-care-of name (if needed)
address, city, state, and ZIP code

Overrides entries on the K1 Shareholder Information screen

4562 Detail

Override regular depreciation, Federal

Overrides the system calculation for the "Current depr" column
of the Depreciation Detail Listing.

Override regular depreciation, AMT (if different)

Overrides the system calculation for the "AMT Current" column
of the Depreciation Detail Listing.

Override regular depreciation, Book (if different)

QOverrides the calculated book amount.

179 expense elected this year, Federal

Overrides Form 4562, Part I, line 6, column (c) and the amount
for the WK_S179L

179 expense elected this year, Book (if different)

Overrides the calculated book amount and the amount for the

WK_S179L..




Overrides Worksheet

QOverride Location

Screen/Line

Field Name

Location of Information Being Overridden

Overrides Form 4562 line 12 (If Method M is chosen there must
be an entry made on line 179 expense elected this year or

179 expense ALLOWED this year, Federal Method EXP must be used). Overrides amount calculated for
WK S179L.
179 expense ALLOWED this year, Book (if different) Overrides the calculated book amount and the amount for the

WK_S179L.

Forc_e . |Placed in service and Like-Kind Exchange Info Qvernges cor_1vent|on determined by the dates of assets placed
convention in service during the year.
"Do not use . - W ieam
MACRS % [Placed in Service and Like-Kind Exchange Info Ovef‘ndes ho:N the system calculates_dgpreaatlc_)n for_ the "Life
tables"” and "Method" columns of the Depreciation Detail Listing.
4562 Part 1
1 Maximum amount if greater than $500,000 (_)verndes the maximum of 179 expense for 2011 of $500,000 on
line 1 of Form 4562
2 Total cost of sec 179 property placed in service in Overrides the software calculated amount of section 179
current year property placed in service during the tax year.
19 Total business income, Federal Overrides line 5 on WK_s179L

Form 3468 Computation of Investment Credit

Qualifying advanced coal project credit,

Overrides the cost entered on the 4562 detail screen as

5a Basis of investment in gasification for section determined by the code (CA) entered in the Investment credit
49A(d)(3)(B)(i) projects code drop list.
Qualifying advanced coal project credit, Basis of Overrides the cost entered on the 4562 detail screen as
5b investment in coal-based generation for section determined by the code entered in the Investment credit code
49A(d)(3)(B)(ii) projects drop list.
o T . . . Overrides the cost entered on the 4562 detail screen as
6b Qualifying gasification project credit, Basis of determined by the code entered in the Investment credit code
investment property not included in (a) above drop list Y
11e Rehabilitation property, Pre-1936 buildings in the Gulf dOverrld.eséhk()a C(:]St enctiereg:n the 45d6.2 dlftalll screen as di
Opportunity Zone etermine ' y the code (RA) entered in the Investment credit
code drop list.
Overrides the cost entered on the 4562 detail screen as
119 Rehabilitation property, Other pre-1936 buildings determined by the code (RB) entered in the Investment credit
code drop list.
11h Rehabilitation property, Certified historic structures in dOverrld.eséhk()a C?}St enctieregé)n the 45(16'2 dsta:l screen as di
the Gulf Opportunity Zone etermine ' y the code (RC) entered in the Investment credit
code drop list.
. Rehabilitation property, Other certified historic Ovemqes the cost entered on the 456.2 detail screen as .
11j determined by the code (RD) entered in the Investment credit
structures :
code drop list.
Energy Credit, Basis of property using geothermal Overrides the cost entered on the 4562 detail screen as
12a energy placed in service during 2009 determined 'by the code (EA) entered in the Investment credit
code drop list.
Energy Credit, Basis of property using solar illumination Overrides the cost entered on the 4562 detail screen as
12b or energy placed in service during 2009 determined -by the code (EB) entered in the Investment credit
code drop list.
. o . Overrides the cost entered on the 4562 detail screen as
Energy Credit, Qualified fuel cell property: Basis of ) ) .
12c property installed determined 'by the code (EC) entered in the Investment credit
code drop list.
. . . . . Overrides the cost entered on the 4562 detail screen as
. Energy Credit, Qualified microturbine property: Basis of . . .
12i 9y Q property determined by the code (ED) entered in the Investment credit

property installed

code drop list.

Form 6478 - Alcohol and Cellulosic Biofuel Fuels Credit

2 Alcohol 190 proof or greater Overrides the default rates. Refer to form instructions.
3 Alcohol less than 190 proof QOverrides the default rates. Refer to form instructions.
4 Qualified cellulosic biofuel produced after 2008 that is Overrides the default rates. Refer to form instructions.

alcohol

Form 8609 - Low-Income Housing Credit Allocation & Certification

2

Schedule A - Annual Statement, Override of computed
rate

Overrides computed rate on Form 8609A, Part |1, line 2.

8845 - Indian Employment Credit

5

|Form 8845 credits from pass-through entities

Overrides amounts from K1F screen, line 13, code L.

Schedule K-1 for 1065 (K-1 P)




Overrides Worksheet

QOverride Location

Screen/Line

Field Name

For section 179 Use Only, 2010 179 exp allowed

Location of Information Being Overridden

Overrides the allowed amount calculated on the WK_S179L
worksheet.

For section 179 Use Only, 2009 179 exp allowed

Overrides the allowed amount calculated on the WK_S179L
worksheet.

Current year QRP 179 exp allowed

Overrides calculated amount.

SS-4 - Application for Employer Identification Number

County & state

Overrides the county and state entered on screen 1.

Date business started/acquired

Overrides the date entered on screen 1.

Form 982 - Reduction of Tax Attributes Due to Discharge of Indebtedness

Beginning of tax year

Overrides default calendar year dates or fiscal year dates
entered on screen 1

End of tax year

Overrides default calendar year dates or fiscal year dates
entered on screen 1

State of Incorporation

Overrides entry made on screen 1 (General Info).

Form 2220 - Underpayment of Estimated Tax (Screen 1 of 2)

10

OVERRIDE installment amounts (required tor 1 or 2)
((8)-(d))

Overrides amount carried from ES screen.

Form 2553 - Election by a Small Business Corporation

Part Ill - Qualified Subchapter S Trust (QSST) Election,
Officer title for signature section

Overrides the entry made in Part |, line H, Title, on screen 2553.

Form 3115 Change in Accounting Method

General Information - Principal business activity code
number

Overrides entry made on screen 1 (General Info).

Tax year of change begins

Overrides entry made on screen 1 (General Info).

Tax year of change ends

Overrides entry made on screen 1 (General Info).

Contact person's telephone number

Overrides entry made on screen 1 (General Info).

25

Parts II,1V Section - Net Section 481(a) adjustments for
the year of change

Overrides amount flowing from Form 3115, section A, line 1h.

Form 7004 - Application for Automatic Extension for Form 1120S

6

Tentative tax before credits (Payments/Credits)

Overrides the amount calculated on From 1120S (page 1), line
22c.

7

Total payments and credits

Overrides the amount calculated on From 1120S (page 1), line
23a.

Form 8027 Em

ployer's Annual Information Return of Tip Income and Allocated Tips

7

Allocation of tips if using other than calendar year

Overrides calculated amount for line 7 of form; place X in line 6
to activate this override.

Form 8082 - Notice of Inconsistent Treatment or Administrative Adjustment Request (AAR)

7

|Corporation's tax year

Overrides dates entered on screen 1

Form 8283 - Noncash Charitable Contributions

Restrictions, Override section

Changes information on Form 8283 from section A to section B
or vise versa

Form 8716 -Other Than Required Tax Year Election

4

|Date of required tax year

Overrides calculated date based on return type election.

Form 8822 - Change of Address

4a Business name Overrides information entered on screen 1.
4b Employer ID number Overrides information entered on screen 1.
6 New mailing address Overrides information entered on screen 1.
8 Daytime phone number Overrides information entered on screen 1.

Form 8873 - Extraterritorial Income Exclusion

b5a

Business activity code

Overrides information entered on screen 1.

5b

Product

Overrides information entered on screen 1.

Form 8925 - Report of Employer-Owned Life Insurance Contracts

[Type of business

Overrides information entered on screen 1.

Client Bill - Ad

ustments and Payments

Billing option (overrides what is set up in options)

Override the option selected in Setup > Options, Billing tab.

Custom paragraph option (overrides what is setup in
options)

Override the option selected in Setup > Options, Billing tab.

Date to be printed on bill

Qverrides current date.
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Index

Numerics
52-53-week year returns 37

A

accounting method
changing 52—62
entering 6

accumulated adjustments account (Schedule M-2) 29

address

change of 5

e-mail 18

entering on Form 1120S 4

foreign 21

on K-1 letter heading 23

out-of-state 18
adjusted basis worksheet 24, 36
adjustments

depreciation 27

section 481 8

to income and expenses 33
advertising expenses 10
amended

11208 returns 5, 15

K-1 letters 23
amortization 11, 25
analysis of accounts (Schedule M-2) 2931
asterisks (on K-1 codes) 20
attachments

binary (PDF) 3942

Form 8825 statements 33
auto-balance 26

B

bad debts 8, 9
basis 24

see also adjusted basis worksheet
binary (PDF) attachments 4
book-to-tax differences (Schedule M-1) 27
business activity codes 5

C

calendar-year returns 5
change of name or address 5
charitable contributions 19

Client Communications Editor (for letters) 23

codes
business activity 5
error/reject 38
K-1 20, 36
miscellaneous (screen 1) 18
multi-form 31, 53, 59, 61
compensation of shareholders 8
contact information (for state returns) 18

cost of goods sold, see Schedule A (Cost of Goods Sold)

cover letters (K-1) 23

coversheets 36

credits 33

Ctrl+W (detail) worksheets 6, 7, 43

D

data entry
for state information 16
importing trial balance into 42—52
dates
of incorporation 5
payment (changing) 13
tax year 5
decrease to basis 24
deductions 8—11
depletion 10
depreciation 7
and auto-balance errors 26
expense 10
for cost of goods sold (Schedule A) 7
of rentals 31
on short-year returns 5
printing Form 4562 36
trial balance (business returns only) 50
detail (Ctrl+W) worksheets 6, 7, 43
direct debit of balance due 13—14
direct deposit of refunds 13
distributions 29
domestic production activities deduction 22
due dates 13

E
e-filing
Form 1120S 37
PDF attachments 39—42
statements 25
electronic
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funds withdrawal 13—14

signatures (PIN) 15
employer identification number (EIN) 5
envelope coversheets 36
error codes 38
estimates

2008 tax 12

2009 payments 12

underpayment of 12
expenses 8—11
exporting K-1 data 21
extensions 14

F

filing instructions 36

final return 5

fiscal year returns 5

foreign
addresses for shareholders 21
transactions 13, 19

Form 1099-K (Merchant Card and Third-Party Network
Payments) 6

Form 1125-A 2

Form 2553 (Election by a Small Business Corporation) 4, 5

Form 3115 (Application for Change in Accounting Meth-
od) 52—62

Form 4136 (Credit for Federal Tax Paid on Fuels) 12

Form 4562 (Depreciation and Amortization) 31, 36

Form 4797 (Sales of Business Property) 7

Form 5884 (Work Opportunity Credit) 33

Form 6478 (Alcohol and Cellulosic Biofuel Fuels Credit)
7, 33

Form 6765 (Credit for Increasing Research Activities) 33

Form 7004 (Application for Automatic Extension of Time
to File) 14

Form 8050 (Direct Deposit of Corporate Tax Refund) 13

Form 8820 (Orphan Drug Credit) 33

Form 8825 (Rental Real Estate Income and Expenses of a
Partnership or an S Corporation) 3133

Form 8844 (Empowerment Zone and Renewal Community
Credit) 34

Form 8845 (Indian Employment Credit) 34

Form 8846 (Credit for Employer Social Security and Medi-
care Taxes Paid on Certain Employee Tips) 9, 34

Form 8864 (Biodiesel and Renewable Diesel Fuels Credit)
7, 33

Form 8873 (Extraterritorial Income Exclusion) 11

Form 8881 (Credit for Small Employer Pension Plan Star-
tup Costs) 34

Form 8903 (Domestic Production Activities Deduction) 22

Form 8912 (Credit to Holders of Tax Bonds) 33

Form 8912 (Credit to Holders of Tax Credit Bonds) 34

Form 8916-A (Supplemental Attachment to Schedule M-3)

28

Form 8932 (Credit for Employer Differential Wage Pay-
ments) 34

Form 8941 (Credit for Small Employer Health Insurance
Premiums) 34

Form 8941 (Credit for Small Employer Health-Insurance
Premiums) 11

Form T (Forest Activities Schedules) 10

G

gains and losses 7
gross receipts 6

H

header information 4

import, trial balance 42—52
inactive returns 36, 38
income 6—8
increase to basis 24
instructions for filing 36
insurance proceeds, income from 8
interest
expense 10
income 8
inventory 6

K

K-1, Schedule for 1120S 19—24

L

labor 8
letters (K-1) 23

maintenance costs 8
Multi-State Apportionment 2, 16

N

name change 5

net operating losses (NOL) 31
next-year depreciation listing 36
number of shareholders 6

(0

ordinary gains and losses 7
other

viii
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Index

adjustments account 30
costs (Schedule A) 7
income (loss) 7

P

passive income 11
PDF (binary) attachments 4, 39—42
PIN (electronic) signatures 15
printing
cover letter for K-1 23
K-1 items 20
line 22a worksheet 11
statements for Schedule L 25
suppressing/forcing documents 35

R

real estate 50
receipts 6
references to forms and worksheets 36
refunds
direct deposit of 13
state tax 8
reject codes 38
rent paid on business property 9
rental activities 31-33
repair costs 8
retained earnings reconciliation (worksheet) 36
returns
52-53-week year 37
amended 15
bankruptcy 37
extensions for 12, 14
fiscal and calendar year 5
inactive 38
short-year 5
signing 15
tax-exempt organizations (990) 39—42
updating prior-year 3
revocation of S election 5

S

S corporation
changing to 4
electing as 4
termination of 5
scanning (PDFs for e-filing) 39
SCH2 screen (for Schedule L) 25
Schedule B (Other Information) 16
Schedule D (Capital Gains and Losses and Built-In Gains)
bad debts 9
Parts I, ITI, and IIT 12

Schedule E (Officer Information) 18
Schedule K (Shareholders’ Pro Rata Share Items) 18—19
Schedule K-1 (Shareholder Information) 19—24
Schedule L (Balance Sheet per Books) 2527, 35
Schedule M-1 27, 35
Schedule M-2 2931
Schedule M-3 28
schedules on Form 3115 56—60
section
179 income limitations 8
481 adjustments 8
481(a) adjustments 55
shareholders
adjusted basis worksheet 24
compensation of 8
foreign addresses for 21
multiple 20
number of 6
Schedule K-1 19
updating data annually 24
short-year returns 5
signatures, electronic 15
state
address 18
-specific information 16
tax refunds 8, 13

tax

and payments 11—12

on fuels, credit for 7

returns, see returns

years (fiscal vs calendar) 5
taxes and licenses 9
termination of S election 5
trial balance import

and depreciation 7

and Schedule L 25, 26

instructions for using 42—52

U

underpayment of estimated tax 12
undistributed taxable income previously taxed 31
updating

an 11208 return 3

shareholder data annually 24

Vv

Vista (Windows operating system) 43
vouchers 12

Tax Year 2011
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